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LB, ACTETEDT T ZHHENTLEEY, &b TE, v~ —FR— LR 0N
BARBEEZZ LD bHVET, 2 TCETRICTF v 7 LI T, ACERa— KD 7
T LIAATLEE N,

1. ATXEBFEAHIXI X
ZOVYP—R—=RE3oOBEF %7 ¥ B4 L T ATXI12V EFIEE ISR L E T,

E: 2024 BUERIARZ X “ATXPWRI” [XIH 20 B ¥ A FIZHIGE L TWET, ZOEE,
EYOFMIZEZRLTLZEN (B 11, 12, 23, 4 EREROETE LRV ET) |

FataLjy ANS SLI

1
GND—fe](s3— GND
+12v —felloh— +12v

24 12

ATX12v1 ATXPWR1

REaRRbEAREEN
&

i AMOEVWYAT AOHAIE, L7 &b 350W, 20A +5VDC FEOD, O 2 Lk
PR— b T HEEIE. D L bR 2A+5VSB REOEREBICER T L) cBBO LE T,

12V #HBNEF T & # & [ATX4P1] 7 PCI Express AW v MCEBINE

O 00O NIZTNA 2D DISEMERZ . ¥ AT 2OLEREZEL.

BEMD 12V BREERT A LEHELET,
ATX4P1

y — Z—P—r==2 T
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(2. FAN a7 ¥
INLaARI FEFENEN VAT AL A M= AVENTI =) 777 NZEREME L E
T

e  CPUFAN1:CPU 7 7

e NBFANI: v 7y b7 7V

e SYSFAN1: VAT L7 7

e  AUXFANI1 : M7 7 >~

e OTESFAN1, OTESFAN2: OTES 7 7 o/

BE . INODT77raRx g ZE VxR TRDY EHA, TNHEDOIART XYY 3F X
FENSERNTL S,

N

"X CPUFAN1| ©

(X otESFaNt-~2 -

GND
+12V
SENSOR
FAN

Fatallty AN8 SLI
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3). CMOS AEY I VYT IV I~ H

ZDCCMOSI ~y ZI¥ v 3% ¥ v 72MEM LT, CMOS A £V A2HELET,
o vri12va—h (F7x0b) : EYERE,
. B> 23 a—b :CMOS AE Y DiEE,

H:CMOS AEV A7 J—=V 7T HHNIT, ETHSV RAZ UL BREZEZD)ERE A 71T L
TLIEZEW, SHRTFIUL VAT AR REREMEL I SR L0 &9 2 mRetEn d v £9,

Normal ! [u]
2 i
(Default) 3 n

ClearcMOS 2 @
3 L

CCMOs1

o=

A=

Z—P— =2 T
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@). HE ASFNDAAL v F LA Py — BBk

DO~ EE, AL v FELED A U —H &y Y — VRIR S FVICERG T 272D A S
5,

IR LED O B UALE & FIIZIEL TSN, FRIOE A~ BT A TN DD~ —27 1%,
LED ##iD 77 Az R LET, INOHO~y XITHEWR R L T 7ESW, iz
Bae LCH LED 25T LARAWEIT D Z & TN, AL v FOME S ZHktIE s AT L DOED
JRINERDZ N £,

SLED PWR PLED

—r— r—
2 20
1 19

[ } E— | [

HLED RST SPKR
FPIO1

D HLED (E°>1, 3)
¥y — VRN R VD HDD LED 77— 7 /W28 L £ 97,
RST (¥>'5, 7)
VX —UHIE SRV D Y 'y NAAL v F =TI ERE L ET,
o SPKR (¥ 13, 15, 17, 19)

VXV DYVAT ANAE—h—r—T W L E T,
D SLED (E 2, 4)

¥y — VI SRV D AR RLED 7 —7 0 (b L) I8 LET,
e PWR (EF 6, 8

X =7 ay NRNVOERAAL v Fr—TVICHRR L ET,
e PLED (t' 16, 18, 20)

Vx—v7ay MIRAVOELED r— 7 WL E T,

Fatallty AN8 SLI
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(5). B USB B—h~v ¥

INHED~y ZiEENE N, USB 2.0 AR L Tk &N/ USB 7y —7 L &i@ L T, 2 DDA
JNUSB 2.0 A— M a4t L E 7,

10(m_|

g(mml7

6mul5

4(mm3

2 [(mm1

FP-USB1~3

(S EVENE (=% HY LT

1 vCC 2 vccC
3 Data0 - 4 Datal -
5 Data0 + 6 Datal +
7 T—A 8 T —A
9 NC 10 NC

(6). iBANIEEE1394 B—b~v &

INED~y ZIENTEN, R —TNVET Ty FEELT, 1 OB IEEE1394 AR— k
P et L £,

!
10864 2
FP-1394-1
S Eln YT =% Eln YT
1 TPAO + 2 TPAO -
3 7 — 2 4 7 — 2
5 TPBO + 6 TPBO -
7 +12V 8 +12V
9 NC 10 7 — 2

4 Z—f— = T




2-14 g2 E
N V=0T T~ ¥
321 321
Disabled Enabled
(Default)
PS2-PWR1
USB-PWR2
1@ 1 (m) (m)3 /3
20 2 g 2 g2
3 (m) 3@ (= (] 1
Disabled Enabled Disabled Enabled
(Default) (Default)
USB-PWR1 USB-PWR3~5

PS2-PWRI :

Er12va—h: F—R—=R/vTRAR— b TOV=—27 T v THEREOYR— k&85
WZLET,

vr23va—h (F740F)  F—R—=R/FUAR=FTOU=—2 7 v FHEED
PAR—NEHEHLET,

USB-PWRI :

By 123a—h:USBIAR—hTOT=2—2 7 v 7HEREZ I LET,
vr23va—h (F7x/F) (USBIR—FTOY=—2 7 v FHEREEZHDICLE
ER

USB-PWR2 :

By 123a—h :USB2R— FTOY =—27 7 v THEREZ BERHZ L E T,
vr23va—h (F74/8) (USB2R—FTOT=2—2 7T v FTRERER AR L £
S

USB-PWRS3 :

v 123 a—h :FP-USBl R— FTOU = —7 7 v e BN LET,

v 233 a—hk (F74/K) FP-USBl R— hTOYx—2 7T v FHERER AT L
3

USB-PWR4 :

B 123 a—h :FP-USB2 AR— FTO Y =—2 7 v FHEREA TR L E T,

vy 23va—h (F744b8) (FP-USB2R— FTOYz—2 7 v FHREZHB L
3

USB-PWRS :

Er123va— bk :FP-USB3AR— hTOY=—7 7T v =B L ET,

vy 23va—h (F744 b)) FP-USB3R—FTOYx—2 7 v FHEEZ AL
7,

-
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(8). GURU 7 2 v Z i~ &

Z O~y 1L ABIT O GURU 7S L T3, 7 L <IXFHAD GURU /SR /LA R h—)L
HA K% DB TS,

=@ _ 0 Q
)

FaTa]ry ANS SLI

PR
|

GURU1 |

A 4
GURU1

4= Z— =2 T
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9. ZvyE—L IDET A RAY RFALTaxI 4

IDE2

IDE1

FDC1

%
%

FDCl a7 X334 VA Y 2axr 270y = —7 L TRRK2OO72y E— I T%
BT A M TEFET VARV A —TALDOEWHIZHD 1 DO X% KR— RO FDCI |24
el, bIORFO2o0axs %70y =T 4 A7 RTA4TIZERHEL T ESV, lE, &
AT AIRER Ty =T 4 A7 RT4 7131 27 TY,

E: VAR —TNLDORVEIEIFDCI AR— & 7 a vy E—aRx 7 ZOW DO 1 IZEbYE 5%
ERH Y ET,

K IDEAR—ha 37 XTIk 40 B2, 80 & U X

Master Drive

3 2k Z® Ultra ATA/66 VR r—7 L&~ T Black Connector
Ultra ATA/100 E— R CTHRAK2D2DIDE KT A 7 %% 40-pin IDE piug
flf%@— HZ & NT % i @‘0 on the motherboard

Blue Connector
VYR —TNAOREVHTON (F\Waxs¥) 220
RN— RO IDE A — MMIHE L, BT Oz 2
DDARTE (RELBOaAxXRy ¥y /N—FF7A
TOaRT ZITEHE L TLIZE 0, Slave Drive
Gray Connector

H: VAR —T N T2o0D K747 Z8Hid HRIIC, "Master" & "Slave" BIfRZREL T 72
EV, VR =T A DOFRVERL IDE R—hEN— R KIA4 T axs ZOlFOE . 1 I2h&b
TLEMERDH Y F9,

Fatallty AN8 SLI
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10). YU TV ATA o X7 &

IhbDaxy Zid, Serial ATA 77— 7 U THF ¥ R 1 DD Serial ATA F /31 2%
BT 2 e DICHE SN TVET,

o
o
=3
o
<
<
s
@
»

SATA4 SATA2

SATA3 SATA1

A1) AT —F AL VT —¥

LED1 (5VSB): Z® LED %, EREENERICERINTND L EITAITLET,
LED2 (VCC): Z®D LED (X, Y AT ADOBFENBA TR TWNDH EXITEITLET,
LED3: Z®DLED IV AT AN SLIE— RCEBHLTWD & XIZHELET,

© ©

5VSB VCC
- . LEID3
LED1 LED2
L=

“ Z—f— = T
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(12). POST 2— FF 4 2L A

ZHiE, “POST’a— K& FK/RT 572D LED 734 A T9, POST % Power On Self Test (DA
FETY, arta—XE, BREAICENDTZNTPOST 77 v a v & FEfTLE 9, POST AL
FIXBIOS Ik o TCavbu— L E&NET, arBa—FDEI L R—3 b & EDEROREE
T 0SSN ET, 4 POST 22— Rit, Aib > TBIOS ([CLk» T &R 5
Fzv IR MIHIELTWET, FlziE, AV FET AN BEERF=v 7R A b
T, Z® POST 21— R{E“C1”C9, BIOS (X POST 7 A 7T L& FEATL T 5 & & %95 POST
a— RK%&7 RL R 80h IZEEXIAAFE T, POST /32 ¢ 5 & BIOS (FRD POST 7 A T L %KL
PEL, RO POST =2— K% 7 KL A 80h ICEXIALE T, POST WRIRTDH &, FxIET RLA
80h TPOST 2— K& F=v 7 LEZICHERHLZONnZELELET,

Z® LED T34 A, ABIT 22 Ea—# 2l EMIZBRE Lz“uaGurn”F v 7Ty hTHD,
AC2003 D“POST"=2— Kb FE R LET,

EE: ZO/NEAIEL, AC2003POST 77 a v Z2FETLTWA & X ITAEIT LET,

AWARD ¥ L Y AC2003 POST 22— REFKDOkaE ZEL 2 &0,

/.
A
y f—
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(13). PCI Express x1 A& » |
ZhboArmry ME, kRO V0 7—%7 7 F v B T,

PCIE2

(14). PCI Express x16 A2 v b

Z D= HP—R— Fi&, PCIExpressx16 777 ¢ v 7 51— K 1 #, 7213 PCI Express x16 ##%(Z

YEHL LU 7= SLI *fits PCIExpressx16 777 4 v 7 — R 2 &2V R—FLET,

- @745: R—FTlZ. T74N D TEBH#) =— T, 1O T 574 v 27— RMEENT 5
IMEINTNET, [PCIEXP1] A1y M, PCIExpressx16 & L THfE L, [PCIEXP2]

li PCI Express x1 & L CH§RE L £7,

OV —R—=RKT2HDI T 7 v 71— RE{FEHSH 521X, SLI AA v F KR — K% [SLIJ

E— ROV BZ TR MLERSHY 7, 7ELLIE, BZ v 2> 24NVIDIASLI 77/ ay
T2ODT T 7 v I h—KREA LA M—)b] OFHAE TSRS,

PCIEXP1
I

y Z—P—r==2 T
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(15). SLI Switchboard 2 2 » k

DAY FETLAUAM—VENTZABITSLI AA v FI13T7 T 7 4 v 7 F— REEREE X
SLI F— RIZWTINIIEELET,

A8IT-SLi SWITCH

Normal

Fatallty AN8 SLI -
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(16). AUDIOMAX #f 22 > |k

Zmy b TAUDIOMAX1) (&, A—F 44 F—=F—h— F&l L CER/ SR/ A—T 1 4 A
VANIERPAL < ik iy U S

#: 2y b TAUDIOMAX1] (22D F—% —h— &Y £,
©

= B ©
= B AudioMAX
) 7.1

o

SPDIF OUT OPT-OUT1

JK1
cD1

JK2

=
uneien | |
men ]
[ 3
I
I
I

4
i FP-AUDIO1
g

Fatac]ry ANB SLI

Cen/Sub JKa

RLURR. JKS

@@@@@@ﬂ

SLISR. JK6

r 00RO

Y

©

AUDIOMAX1

Audio Daughter Card Bracket

e SPDIFOUT : —hax7 X, 77 ANRNEZBLTCTIEZNSILTF AT 4 TFINA A~
@ S/PDIF 7 7 Mkt & 24k L £ 5,

o Line-in/IN : ZHI~ NV FHfea 7 Z T, ZOax 7 XiF, K7 7A@ LTTY
AN~ VT AT 4 T T34 AT S/PDIF-IN e 22t L3, F7/=, M4 —T 1 A4V —
AMBEDTA VNS bERTHZ LN TEET,

o Mic-in : AN~ A 7 N7 T 7R LET,

e Line-out: 7.1 F¥ XV EZITBED 2 F ¥ FVA—F 4 A4V AT LAORIHE & RilifA T
T RATEERE L E T,

e Cen/Sub: 7.1 F ¥ FNDA—F 4 F LV AT LD F—BLOY T 7 —7 7 F v F/LIZ
Bt LET,

e RL/RR. (FHE / FEAE) :71F v RADOF—F 4 L AT LD HLES LY
EAT ¥ R/ LT,

e SL/SR. (FZUVNEMNTFIVREA) 4TV NELEH T REF YU RV E
T1F ¥ RN T—F 4 F AT MTHERE L TLE &,

A= Z—P— =2 T
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S/PDIF st

The optical fiber cable

Rubber protection-cap

Optical adaptor

3.5 mm adaptor

\
\\
\\
\
|
AN
)
J
= Rubber protection-cap
>\“’\ —
)
\/J

AE: TONT 7 AN =TT HANC, FLROERHET ¥ v T RS LTI SV,

S/PDIF H{77854% -

1. 35mm DT X T EZERFNPLFEHLTLIEEY, EYE F—4Z 75— KO [SPDIF
OUT] V¥ v 7 IZHHLET,
2. bINFET VLN~V F AT 4T 5734 A0 [S/PDIF In] (Digital In) ¥ % v 7 (28

ftLET,

SIPDIF In <:|

AudioMAX
71
OPT-OUTH

CD1

1 M1 /1 /3 3 [

JK3

JK4

JK5

JK6

©) N T T

0O O

=
==

FP-AUDIO1

Fatallty AN8 SLI
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S/PDIF A\ 115

1. 3.5mm 7 ¥ 7 X DO Huia Z 0O K—%J3— RO [Line-in/IN] ¥ v v 7 22 LiAHE T,
(ZDOV% v 7T ETITTA VATNMEHALET, )
2. bINFETOEN~IF AT 4 T34 A0 [S/PDIF Out] (Digital Out) ¥ % v 7

WA LIARET,
7\<§\\V} :::% ©) AudioMAX
Q 71

OPT-OUT1

o

OO

SIPDIF Out |:> do| 0 )
JO0000~

JK1
cD1 @
JK2 E

K3 FP-AUDIOA

|
|
|
|
|

JK5

JK6

“ Z—f— = T
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Line-in Z56¢
1. B3 SmmA—F 4 AT LA —TNADOR F% F—% 57— RO [Line-in/IN] ¥ v
I LIARET,
2. bIORFELNF AT 4T T34 AD [Line-out] ¥ % v 7 |Z#E LIAZRET,

— AudioMAX
71
OPT-OUT1
o= ca={ M= | []
-
JK2
K3 FP-AUDIO1

JK4

JK5

1 1 1 1 1

T I I

JK6

M0 0

5

Fatallty AN8 SLI 4=~
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T1F %V RENE—F 4 VAT LA T F 0 7k
TRUZHEW, T RVRT LA —T 4 A K= — NIk L T 7EE0,

SPDIF OUT

Line-in/IN

Mic-in

Line-out

Cen/Sub

R.LRR.

S.L/SR.

@@@@@@ﬁmﬂ

(bbb L LLl EULLLLLELLLLLLLL LU LU DL LU L] |
1 L 1
1 1 Ll
1 1 Monitor Subwoofer 1
1 1 1
I 1 —— 1
1 1 1
' Lef . Right
t i
: © Center : ¢
H 1
1 1
N 1
1 1
| ! ! [
CETT T
1 1
1 1
1 1
S e

Surround Left Surround Right
4. —

et 1] X I

1
] 1 ' You are here 1
4

: B o -

L}

L}

: Rear Left Rear Right
1

L}

L}

1

1

e L L T L L L L T LT T T T T PRI |

L»“ﬁ\

Z—P— =2 T
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(17). B SRV DA —F 4 A~ &

TNy AL, TRV RRRVTOA—T 4 A 337 ZICHR 2RI L ET,

B/ S XN TH—T 4 Aax s 2 2R 51203,
VX — VI BT DR — 7V CHIE SR VICERE L £ T,

TN EDTRTOT ¥ %A L.

WH ANV TH—F 4 Faxs ZEREHTHI20E, EEF—T LV 2HKE, U 56, BLOr
910 DY v RETLICRELET (F 74V MRE)

AudioMAX
71

OPT-OUT1

CETT [ [ o

§
FP-AUDIO1

S LR = FY YT

1 A —F 4 4 Mic. 2 T — A

3 F—F 4 FMic./ 3 T A 4 vCC

s A—H—T 7 NOF 6 AV —N—T T FOA
F v v Fypny F—r

7 X 8 NC

9 A —H—T U NDE 10 A —Hh—T 7 FDRE
F ¥ R Fy N H—

Fatallty AN8 SLI
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318). A —FT 1 Aaxr ¥

InH0axs Hix, WEECD-ROM KT A 7 E£72137 KA — R4 —F 4 I L
e N

AudioMAX
71
OPT-OUT1

JK1

JK2

JK3

JK4

JK5

ol I T I | | Jdo

JK6

CD1

L»“{\

Z— =2 T
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(19). WHE SRV DB
LAN1
Mouse
ond]
o 0%
OTES IEEE1 Keyboard USB1 UsB2
Mouse : PS/2 ~ 7 AT L £,
Keyboard : PS/2 % —7FR— FIZ#kE L7,
IEEE1 : [EEE1394 7’11 s 2L DT S R T L £,
LANI1 : {3 (LAN) 128k L £,
USBI/USB2 : A¥ ¥, TVXNAE—H—, F=H, wTUA, F—HKR—K, T, FIUXIL
HAT, VaAf AT 477 EDUSB T /31 AN LET,
SgEar/,
a
WWW.ABIT.COM.TW
/TL

Fatallty AN8 SLI
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BIOS /Z20T 3-1

# 32 BIOS IZOWT

ZO=YW—R—FEF v /T LA[FEZ EEPROM ZEfit L, BIOS =2 —F 4 U T 4 2 HHT5HZ
ERTEET, BIOS EAAL L AT )37 0t w4 L ENEBOR TRIEDRARL L%
WS 2707 T A5 TT, ~P—R—FEROMIT7Z0, VAT LEFEHER LY, “Ey b7
v T OFEITHFRTHEXIZET, BIOS By N 7T a s I e LET, KAETIE,
BIOS 2 —7 4 VT 4Dy N7 v 7a—T 4 UT s &3 LET,

VAT LADERE A NTT B E, BIOS A v —UNBMEICFRSN, AT YRS T NEBEEG
L. KORA vy e—URNHHEICERINET,

PRESS DEL TO ENTER SETUP

AT AHNCA v —U BT 5. <Ctrl> + <Alt> + <Del>F —Z#37y, v EBa—F Ly —
POV hREZVEMLTAT LAZHEZEILET, ZNDH0 2 DOFENKRBLESEA DA,
EBFEAFT I LB ELA VT LTV AT AZHENTAZ LN TEET,

<Del>F—ZM L7, AV A=a—BEPIRREINET,

Phoenix - Award WorkstationBIOS CMOS Setup Utility
» pGuru Utility » PnP/PCI Configurations
» Standard CMOS Features Load Fail-Safe Defaults
» Advanced BIOS Features Load Optimized Defaults
» Advanced Chipset Features Set Password
» Integrated Peripherals Save & Exit Setup
» Power Management Setup Exit Without Saving
Esc : Quit T ] = < : sSelect Item
F10 : Save & Exit Setup (NF-CK804-6A61FA1BC-00)
F6 : Save PROFILE to BIOS F7 :Load PROFILE from BIOS

OC Guru & ABIT EQ

VAT LORENEMRER M 572018, SO HATHAS BIOS A =2 — %tz TR L T
WE9, BIOS & v 7w Pl & AE TR LERIIZBRO-O0 DT, EHEcHRrEN5
HOEREBIZ—H LRI EHHY FT,

BIOS v b7 v T AL v A =a—ITid, BEOA TV a v RERENET, KEOLITFDOS—
CTINGDF T a v AT v INRAZT vy F T LETHR, 2 2 Tl HHREF—12o
W, FPMEEICHBAWZLET,

|2

ScC:

TORZUEMTE BIOSty T v FEKTLET,

Z— =2 T



3-2 E53 =

T le—on

AL AZ2a—TINLORS 2T & HERELIMEET 24T v a v 2BRTEET,

F10:
BIOS T A= DYy v T v 7TBRETLEL, ZORZUEHLTIHNDNRT XA —F ERLF
L. BIOSt Y T v A=a—%&TLET,

Fatallty AN8 SLI
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3-1. pGuru Utility

SoftMenu = —7 4 U 7 4%, CPU OBERE T 10 7T A9 572D ABIT O EHITIEMD
Ya—3a2CY, CPUFSB#E, v~ VF7I7A4VY 77274, AGP&PClZu v/ CPU=7T
FBIEICHATAETDONRTA—F[ZT Xy F THEIET D Z LN TEET,

OC Guru:
pGuru Utility Vv1.00
[OC Guru [ABIT EQ
Brand Name: AMD Athlon(tm) 64 Processor 3400+ Item Help
Frequency: 2200MHz
CPU Operating Speed 2200 (200)
- External Clock 200 MHz
- Multiplier Factor x11.0
- PCIE Clock 100 MHz
Voltages Control [Auto Detect]
- CPU Core Voltage 1.350v
- DDR SDRAM Voltage 2.60V
- DDR VTT Voltage DDR/2
- nForce4 Voltage 1.50v
- HyperTransport Voltage 1.20v
DDR Ref. Voltage Default
CPU Ref. Voltage Default
Power Cycle Statistics Press Enter
7 | :Move Enter:Select +/-/PU/PD:Value F8: On The Fly F10:Save ESC:Exit

Brand Name:

ZDT AT AIECPUDET VA,

Frequency:
ZDT AT HIECPU OWNE Y vy 7 HELZRRLET,

CPU Operating Speed:

ZDT AT HE, BFEWD CPU DK A 7 LHEIZNES T CPUDARL—T 4 VI HELAZFRL
%9, [User Define] (L —F—iEFH) A7 a v 2BINRTH L, ~=a2T ATy a it AL E
NTEET,

User Define:

BE. oy 7 EBENRI vy I DREERDE . CPUE X A—TVEEZDZENHY 5,
PCILOF v 7ty hERIZZrE v FOHEL D b EWERKICERET S AEFVEY2—/L
TT— VATLITvva, N—RT A AI RTATDTFT—HFa A, VGA 71— Ko7 K
I T — FOBEIMEELRR L AR H Y £9, CPU DL DR EIIAED B TIEH Y £ A,
) LERERT V=T Y I TANDEO T @EOT 7Y r— a3 TEER LanT<
ZEV,

-
-

Z— =2 T



34 EH3 =H

AR 2 D3 EICK L TRARIL CTE £ A, SRR T 2~ —A— R E72i3EDEREOHE
Bloxt L THthiEEE A DRV D L LET,

#  External Clock:

DT AT ALE, CPU T Y b A RARZAOFELEFE L ET, BV AT 72 CPU OAARHIBRIC
L oT, ZOEEDASRAREZBZ THRE LEHEIVR— SN ETN, BEEIShEEA,

%  Multiplier Factor:

ZOT AT AE, WY fHF 7 CPUDRKER R LET,
# PCIE Clock

Z DT AT A% PCI Express O JE 52 BN L E T,

Voltage Control:

IOFTvaFk T AN OBEL - —ER LLBEEZN Y B2 ET, BEOBERT
ﬁlfﬁﬂjfé?fiﬁ>otb?b<fcﬁb\i}/ﬁﬂ)ﬁ%%\_@E)’z“ﬂili772“w}~@ii LTHBNTLZE
VN, A7V 3 “User Define” (= —F— &) (X, IROEBEELZ FECRITEET,

# CPU Core Voltage:

ZOTAT AL, CPUDaTEELBRNLET,

# DDR SDRAM Voltage:

ZOT AT AlX, DRAM OELEZER L ET,

# DDR VTT Voltage:

DT 1T AEVITMEM R— b OBEEZBRLET.
# nForced Voltage:

DT AT A% NBOBEEEZBIRLET,

#  HyperTransport Voltage:

ZOT AT AELDT NAZBELENLET,

DDR Ref Voltage:
D71 TFALAEIDDRXEYVY 77 L ADEFEEZHEIRLET,

CPU Ref Voltage:
D74 TALEICPUAEYY 77 LY ADELEEERNLET.

Fatallty AN8 SLI L=
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Power Cycle Statistics:

<Ente>¥—%27 U v/ 35L $ T A==2—ICAVET,
pGuru Utility v1.00

[OC Guru [ABIT EQ

|[Power Cycle Statistics [ Item Help
PC Up Time 1 Hours

PC Up Time Total 8 Hours

PC Power Cycles 44 Cycles

PC Reset Button Cycles 0 Cycles

AC Power On Total Time 16 Hours

AC Power Cycles 24 Cycles

1 | :Move Enter:Select +/-/PU/PD:Value F8: On The Fly F10:Save ESC:Exit

INSDT AT AL, FEFZONRNT— - A4 7 HHEERLET,

ABIT EQ:

<>F—%fioT, OCGuruty b7 v 7+ A=a—M0H ABITEQ £y N7 v 7« A=a—(C
BV BEZFET,

pGuru Utility Vv1.00
OC Guru [ABIT EQ
Item Help
ABIT EQ Beep Control Enabled
Temperature Monitoring Press Enter
Voltage Monitoring Press Enter
Fan Speed Monitoring Press Enter
FanEQl Control Press Enter
FanEQ2 Control
1 | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit

ABIT EQ Beep Control:
DT AT LT, ABITEQ EhiFrary br— 2B LI EHIZ L2 LET,

uf\
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% Temperature Monitoring:

<Enter>X%—%27 Vo7 95L, VT A=a—Z A ET,

pGuru Utility Vv1.00
OC Guru [ABIT EQ
|[Temperature Monitoring |
Reading Shutdown Shutdown Beep Beep
Enable Temp. Enable Temp.
(*)CPU Temperature 51°C/123°F (*) 85°C/185°F (*) 75°C/167°F
(*)SYS Temperature 33°C/99°F () 65°C/149°F (*) 55°C/131°F
(*) PWM Temperature 43°C/109°F ( ) 90°C/194°F (*) 88°C/176°F
1 | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit

CPU Temperature/SYS Temperature/PWM Temperature:

INBEDT AT AILCPU, VAT A, BIREEOREZF R LET,
#  Shutdown Enable:

<AN—R> F—Effo T, VAT A THEREZANC LET, CPU/System/PWM DIRFEAKE T
BERELZEBRAL L, AT AIABNCKTLET,

#  Shutdown Temp.:
ZOT AT BE VAT LOBAERToDIT VAT 2 E BEBICK T T 0EEEZRELET,
#  Beep Enable:

SANR—A> F—Hflio T, BEFHELAHICLET, VAT L5 CPU/System/PWM DI FE S
BETMREREZMZ - amtT 5 e, BEEMB ET,

%  Beep Temp.:
ZOTAT HE, BERERELBIRLES,
T RTIREE, BHIRED RICRE LR TUIWTERA,

Fatallty AN8 SLI
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%  Voltage Monitoring:
<Ente>¥—%7 U v/ 95L, W7 A=a—IZADFET,

pGuru Utility v1.00
OC Guru [ABIT EQ
Woltage Monitoring [
Reading Shutdown Beep High Low

Enable Enable Limit Limit
(*)CPU Core Voltage 1.550v (*) (*) 1.89vV 1.00V
(*)DDR Voltage 2.70v () (*) 2.90v 2.10V
(*)DDR VTT Voltage 1.35v () (*) 1.55v 1.05Vv
(*)nForce4d4 Voltage 1.52v () (*) 1.80v 1.20V
(*)nForced4 Standby Voltage 1.50v () (*) 1.85v 1.25Vv
(*)HyperTransport Voltage 1.19v () (*) 1.45V 0.95v
(*)CPU VDDA 2.5V Voltage 2.58V () (*) 3.00vVv 2.00V
(*)ATX +12V 11.70v () (*) 14.40V 9.60V
(*)ATX +5V 5.03v () (*) 6.00vV 4.00V
(*)ATX +3.3V 3.39v () (*) 3.95v 2.65V
(*)ATX 5VSB 5.06V () (*) 6.00Vv 4.00V
T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit

All Voltages:
INHDOT AT AIEMOBIEER T LET,
#  Shutdown Enable:

SANR=Z> F—%ffio T, YAT LR THRIEEZAMNIC LET, ST 2EROR/V HIRE X
D@EMPo T2 VR 72 0 T 25813, VAT MFHIICK T LET,

3#  Beep Enable:

<AL= R> X—F o T, BEFHELZANCLET, HETHERORL FBRE LY &
STEVEN -T2 0 T HGEIE, BEEFREY £7,

#  High/Low Limit:
INGDOTAT AT, RV POLRE FREFZELET,
I BVRRADER EVRADEIVEEHRET PLEL’HYET .

uf\
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%  Fan Speed Monitoring:
<Ente>¥—%7 U v/ 95L, W7 A=a—IZADFET,

pGuru Utility v1.00
OC Guru [ABIT EQ
[Fan Speed Monitoring |
Reading Shutdown Beep Low Limit
Enable Enable

(*)CPU FAN Speed 4020 RPM (%) (*) 1200 RPM
(*)NB FAN Speed N/A () () 1200 RPM
( )SYS FAN Speed N/A () () 1200 RPM
(*)OTES1 FAN Speed N/A () () 1200 RPM
(*)OTES2 FAN Speed N/A () () 1200 RPM
(*)AUX FAN Speed N/A () () 1200 RPM
T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit

CPU/NB/SYS/OTES1/OTES2/AUX FAN Speed:

INBHDOT AT A%, CPU, NB, SYS, OTES1, OTES2, AUX FAN ~» ¥ IZHH ST\ 5 7
7 UHMEEFRLET,

¥  Shutdown Enable:

SAN=A> F—FMlioT, VAT ARTHIEZ AN LET, VAT LD, 77 VHER TR
HED BIRNZ L 2T DL, VAT ZAFHBRICK T LET,

#  Beep Enable:

AN RS BT, BEEHAEA AT LET, 77 VMR FIRIEL U IS A,
BRI ET,

#% Low Limit:
INoDTAT AL, 77 VEEOTREZRELET,
BE3EUT IR BLT-T7 7 DB, WEE=FY IR A At L £ 3,
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% FanEQ1 Control:

pGuru Utility Vv1.00

[oC Guru [ABIT EQ

FanEQl Control

CPU FanEQ Control
-Reference Temperature
-Control Temperature High
-Control Temperature Low
-DC Fan Voltage High

-DC Fan Voltage Low

NF4 FanEQ Control
-Reference Temperature
-Control Temperature High
-Control Temperature Low
-DC Fan Voltage High

-DC Fan Voltage Low

SYS FanEQ Control
-Reference Temperature
-Control Temperature High
-Control Temperature Low
-DC Fan Voltage High

-DC Fan Voltage Low

Enabled

CPU Temperature
65° C/149° F
35° ¢/95° F
12.0v

8.0V

Enable

SYS Temperature
45° Cc/113° F
35° ¢/95° F
12.0v

8.0V

Disabled

SYS Temperature
45° Cc/113° F
35° ¢/95° F
12.0v

8.0V

Item Help

1T | :Move Enter:Select +/-/PU/PD:Value

Fl10:Save ESC:Exit

% FanEQ2 Control:

pGuru Utility Vv1.00

[0C Guru [ABIT EQ

FanEQl Control

OTES1 FanEQ Control
-Reference Temperature
-Control Temperature High
-Control Temperature Low
-DC Fan Voltage High

-DC Fan Voltage Low

OTES2 FanEQ Control
-Reference Temperature
-Control Temperature High
-Control Temperature Low
-DC Fan Voltage High

-DC Fan Voltage Low

AUX FanEQ Control
-Reference Temperature
-Control Temperature High
-Control Temperature Low
-DC Fan Voltage High

-DC Fan Voltage Low

Enabled

SYS Temperature
45° c/113° F
35° ¢c/95° F
12.0v

6.0V

Enabled

SYS Temperature
45° c/113° F
35° ¢c/95° F
12.0v

6.0V

Disabled

SYS Temperature
45° c/113° F
35° ¢c/95° F
12.0v

8.0V

Item Help

1 | :Move Enter:Select +/-/PU/PD:Value

F10:Save ESC:Exit

CPU/NB/SYS/OTES1/OTES2/AUX FanEQ Control:

[B#] CRESNLTWDLE, RELBEEOR/MBHIROMAGLEEHRETHI LT

CPU/NB/System/OTES1/OTES2/AUX 7 7 > % %

PEES D LR TEDL DR T,

¥£ : SLI E— R CTEIEL TV A RIX, §3CT?D FanEQ = kv —/LIEHH (CPU, NB, SYS.

OTES1, OTES2, AUXFanEQ =1 hr—/l) ZHEMHZ L T EEL,

/N
-
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#  Reference Temperature:

INHDT AT Ak, CPUNB/System v A7 ADIREA R R LET,

#  Control Temperature High/Low:

Ty VBRI b a T 5 DI DRARBREE & R A R E L E T,
#  DC Fan Voltage High/Low:

77 AT 2 RIKEE L RmEEIEERELET,

E:BVRROER EVRRDELYEEET ILENHYET

Fatallty AN8 SLI =
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3-2. Standard CMOS Features

Phoenix - Award WorkstationBIOS CMOS Setup Utility

Standard CMOS Features

Date (mm:dd:
Time (hh:mm:

IDE Channel
IDE Channel
IDE Channel
IDE Channel
IDE Channel
IDE Channel
IDE Channel
IDE Channel

VVYVYVYVYYVYY

Drive A
Drive B
Halt On

Base Memory

YY)
ss)

Master
Slave

Master
Slave

Master
Master
Master
Master

Extended Memory

Total Memory

Thu. Jan 1 2005

12 : 34 : 56

None
None
None
None
None
None
None
None

1.44M, 3.5 in.
None

All, But keyboard

640K
1046520K
1047552K

Item Help

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F6: Fail-Safe Defaults

F5: Previous Values

F7: Optimized Defaults

Date (mm:dd:yy):

ZOTATHIE[A]L (AL [FIORATHRET 2 Af (@F, BEDOR) 2RELET,

Time (hh:mm:ss):

ZOT AT AIE[E] D]

OB THIET 2 B (BFE, BUEORH) Z@ELET,

& IDE Channel 1 Master/Slave, IDE Channel 2 Master/Slave, IDE Channel
3 Master, IDE Channel 4 Master, IDE Channel 5 Master, IDE Channel 6

Master:

L»“{\
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<Enter>X¥—%7 U v/ FhHL T A=a—ITADFET,
Phoenix - Award WorkstationBIOS CMOS Setup Utility
IDE Channel 1 Master

IDE HDD Auto-Detection Press Enter Item Help
IDE Channel 1 Master Auto

Access Mode Auto

Capacity 0 MB

Cylinder 0

Head 0

Precomp 0

Landing Zone 0

Sector 0

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

IDE HDD Auto-Detection:

ZOT AT AT, <Enter> ¥—% 1§ Z LICL 5 TIDE RTANRDORF XA =L 5 HmNTE L &
IR TWET, AT A—=Z P LICABICRRISNET,

IDE Channel 1 Master/Slave, IDE Channel 2 Master/Slave, IDE Channel 3 Master, IDE Channel 4
Master, IDE Channel 5 Master, IDE Channel 6 Master:

[Auto] (HE)) (ZFET D & BIOS X EDOFEMD IDE R7 A T&2FEH L TV D0 % HEIIZT =
v LET, BOTRIATZERELLLWGA, 2N & [Manual] (v == 7 /L) IZEREL., T
A—ZDEREFTRTHMBEL TND I LEERLTEIN, ELWREEB/LITIE, 7731 2
A =N =R DEHTHEZSZR L TIE S0,

Access Mode:

ZDOTAT AIBHEND IDE TNA AT 7 ATEHE—FREZRBRLET, ZOTATL%T
T4V D [Auto] (HE) BREDEFICLTHL & HDD OT 7 AF— F& HEAYITHRIE L E
ERS

Capacity:

ZDTATEIT A AT RIATOBBIEORBEEZFERLET, —IZ, YA XFT 0 A7 F
Ty I TR TAIREND T4+ — Y MEBRT A A7 DY A XLD DL HNREL 2T
7,

Cylinder:
ZOTAT IV U EOEEHERLET,

Fatallty AN8 SLI L=
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Head:
ZDT AT KIFGAIFEIAN Y RO AR L E T,

Precomp:
ZOTAT L, FAZA IV T EEETHV ) VA ORERRLET,

Landing Zone:
DT AT AT, FH /EABA~Ny KOS o F 40 7y — L LTHESND YU VA DFE
BEFRRLET,

Sector:

COTATHE Ty IBODRs ZFOREKELET,

% Standard CMOS Features Setup Menu (2R YD £7 :

Drive A & Drive B:
ZOTATHTWOMTFle7ny = R34 7 @BFE. NI4T ADH) ODFATEFELE
T

Video:
ZDOTATAE, —RVATLEMATHERINDIET AT X T OXA TR LET,

[EGA/VGA]: (Enhanced Graphics Adapter/Video Graphics Array) EGA, VGA., SVGA, PGA £=%#
TET DL,

[CGA 40]: (Color Graphics Adapter) 40 1 7 & — K CHR#H),
[CGA 80]: (Color Graphics Adapter) 80 77 7 AE— R CHYEH),
[Mono]: (Monochrome adapter) mfRGEEDE ) 7 0 — L7 X7 X & kllIir .,

Halt On:

ZOT AT AL, VAT AOEBPIZ T =R SN2 G G, VAT AEEILT A0 E I 0 E
WELET,

[All Errors]: A7 A7 — Fid, BIOS BEMA TRV 7 —%KRiNT 2 &P EILLET,
[No Errors]: AT A7 — NI, =7 —%HRHT25EEIELET,

[AllL, But Keyboard]: ¥ A7 A7 — ME, ¥—FR— K27 —LSHOTXTOTT — % L TEIE
LET,

[All, But Diskette]: > A7 A7 — hE, T4 A7 v hZT7—LIAOTRTOZ T —|Tx L TEIL
LEJ,

[All, But Disk/Key]: ¥ A7 57— NI, T4 A7 v MELIEIF—HR— =7 =PSSO TXTO
7= L TEIELET,

y
p
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s &3 &

Base Memory:

ZOTATAE, VAT ACA VA M= VENTIER AR Y OREFRLET, AT Off
1% 640K Z5H U722 AT AOBHA—MHEITIE 640K TT A, v P —R—FIZEHIZEL D AT
VHA X% A M—ATHZ LB TEET,

Extended Memory:
ZOTAT LIE YAT OB PITHH SNIILRA T ) OBZFRLET,

Total Memory:
IOTAT AT, VAT LATHHTE 2R AT 2FRRLET,

/7—
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3-3. Advanced BIOS Features

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Advanced BIOS Features
» Removable Device Priority Press Enter Item Help
» Hard Disk Boot Priority Press Enter
» CD-ROM Boot Priority Press Enter
First Boot Device Removable
Second Boot Device CD-ROM
Third Boot Device Hard Disk
Boot Other Device Enabled
Swap Floppy Drive Disabled
Boot Up Floppy Seek Disabled
Boot Up NumLock Status On
Security Option Setup
MPS Version Ctrl For OS 1.4
Delay For HDD (Secs) 0
Full Screen Logo Show Disabled
Disable Unused PCI Clock Enable
T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Removable Device Priority:
ZDOT AT HIY D= TIT 4 A7 OEBESNEN 2RI L £ 3,

Hard Disk Boot Priority:

ZDTATAE, N—FT 4 A7 DT — MERIBN 28R L FE9, <Enter>F— %4 Z LTk
ST EDHFTA=a—ICAY, ZZTHRIESNIoN—RT 4 AT B VAT METO-ODT —
o=l ARG 22 LN TEET,

ZOTATHE, VIRRKBRT — b TNA AT AT EADEANBI[N—RT 4 AZIDFT T 3
VIRBDHEEOHRBEELET,

CD-ROM Boot Priority:
ZDT AT Al CD-ROM 7 /34 2D BB SEIEAr 2 B4R L £ 7,

BE: ZOT7 AT A, 2 E2—F|2CD-ROM T34 ARA VA F—/LENTWBHIBHED I
KrShxd,

First Boot Device / Second Boot Device / Third Boot Device / Boot Other Device:

[First Boot Device] (55 1 77— k7734 R), [Second Boot Device] (5 2 77— b 7 /XA R), [Third Boot
Device](55 3 7— b T /XA R) TA T ATENLIERBITHHE 1, H2, F3 R4 TERBRLE
o BIOS [FEBR LI FTA T DY =7 L R TANL =T 4 VTV AT AERBLET,
LD 3 2DT AT AUSNDT IS, A5 ILE) LIZWIEA L, [T /34 A % L8] % [Enabled]
(FEATRE) IR E L TLEE W,

-
-
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Swap Floppy Drive:

[Enabled] (fEHIFIHE) IZBXE L TWDH L XIZ, VAT LE TRy E— RIS TNHEET D &
VAT AIWEFEDO RTA T ADORDYVIZ R T A T BLEEI LT, ZOMiEEZ#FHT 51
VAT AI2EDT Oy E—RIA TEERH L TV DILERH D FT,

Boot Up Floppy Seek:

WD 2 >DA T 3, Disabled(f 9 5)E 721% Enabled{E T )N ETEE T, T 741
M Enabled(fE/ L7200 ) TT, 7 7 4 /v b OFEEIL Enabled. T3, ZOHEHIL, BIOS 23, kit
@ First,Second,Third D 3 DD 7' — MERRLUN DT NSA ANL T — N FHZ L 2HELET, [
B ICHELET L, FRTRELE3SOWBRNLDORT— N LET,

Boot Up NumLock Status:

ZDTATAE, VAT ANERET D L EITREF—R— FOT 740 b DREBEZRELET,
[On] : B3 — & LT — 3> FHRE,

[Off] : KHIF—& L COHEx— 3y MR,

Security Option:

IDTAT AL, VAT LEABRRAT—=REERTDHEE - VAT APNERT L7200, 20
BIOS ty N7 v FICAD L ZDHPERELET,

[Setup]: /SAT—RKIZBIOS v N7 v FIZT 7/ BATH L EDRERINET,
[System]: /XA T — NIz Ea—4nEEhT57-NCERISNET,

X2 VT o BEEE BT HITIE, A A 2 A ==2—T Set Password Z3&IR L F 4, XRAT—F

EANTDEICERENTHMHANIETIZ, <Enter>F—%2 ML TSV, EF=2V T 4

HIRBET D E AT AN T — L, HHICBIOS Dty b7 v F A= —|ICHBICT 7B ATE
W20 9,

E:RRTU— REEn2NWTL EE N, NRT— RE2ENEEE, 2 Ea—FDr—A%ZET
T. CMOS DT _XTOEREZ VTICLTHOLY AT LAEZRE LT EEN, ZOEBRA. P

WRELTEITRTOLA 7Y a iy h&hET,

MPS Version Ctrl For OS:

ZOHEHEIEX, IO —R—FRHEATD MPS (ZETat v ) o=V g UEREL
F7, 037’4’7Ai ZOT 7 AN INOFREDEFIZLTEBNTFE,

Delay For HDD (Secs):

ZDOT AT ALY, BIOS [LBIERFM % 5] & IEIX 9 Z LIZ L » T D F 7287572 IDE 7
NARZYR—F THIENTEET, BERELITDHE, TS AL LEVEETE D
Wl %3 5 72 OBERFE AR < 72 0 37,

Fatallty AN8 SLI
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Full Screen LOGO Show:

COHEAFTEWHT L EREHOn TERTILEEED,

Disable unused PCI Clock:
ZOFTa ik, HHENTWRWPCI AR Y hD7 vy 7 ZERARAREIZLET,

[Enabled]: > A7 AIRMEHDO PCl Ay MEBHBIPIIHRE L, ZHHORMEH PCl Am > b
~DY vy I EHEOEEEEIELET,

[Disabled]: > AT LTI T_RTHOPCI AR Y M7 ua v 75522 EELET,

VAT ANHBNICRH TERWT X TN SHA. T DA 7 3 % [Disabled] |2 5% &
THE, BIEORR L 220 £,

“ Z—P—r==2 T
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3-4. Advanced Chipset Features

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Advanced Chipset Features

HT Frequency 4X Item Help
HT Width l16 T16
» DRAM Configuration Press Enter
SSE/SSE2 Instructions Enable
System BIOS Cachable Disable

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

HT Frequency:
M Z DT A5 L%, LDT N AEA RN L ET,

HT Width:
ZOT AT AL, LDT NAEREEZRINL 9,

% DRAM Configuration:
<Enter>F—% 27 Vv 7 92L YT A=a2—ITAVET,

Phoenix - Award WorkstationBIOS CMOS Setup Utility
DRAM Configuration

DRAM Timing Selectable Auto Item Help
X - DRAM Clock Auto
X - CAS latency Time Auto
X - Row Cycle Time Auto
X - Row Refresh Cycle Time Auto
X - RAS# to CAS# delay Auto
X - RAS# to RAS# delay Auto
X - Min RAS# Active time Auto
X - RAS# Precharge Time Auto
X - Write Recovery Time Auto
X - Write to Read Delay Auto
X - DRAM Command rate Auto
X - Burst Length 4 beats
X - Bank Interleaving Enabled

32 bit Dram Memory Hole Auto

MTRR mapping mode Continuous
T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults
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DRAM Timing Selectable:

CD7 AT AIDRAMZ 1 3 > 7 E— F&ERL 9, “By SPD” ICFRTET 5 & BIOS 1Z DRAM
EY2—)VSPD T—&EHAIY . HEFICRESNIEICEELEST., CO7 17 AE80E
D “Auto” REICLTIBNTL ZE N,

# DRAM Clock:

ZDT AT AE, DRAMEY 2 —/LD DRAM 7 12 v 7 %3%E LE 9, DRAM £ ¥ =2 — ViR E
LizZayZ &Y R—bFLRNE, VAT LNIRLEEILRD, BEITE RN E7,

[SPD (C & A)CE%ET % &, BIOS |Z DRAM £ 2 —/L D SPD 57— & 3t HIAA T, IS h
TWAEIZ L > TDRAM 7 2 v 7 % HEWIICRE LT,

#  CAS Latency Time:

3O00FTvar, 225D 3EMATIILENTEET, T 74N MNOBREIT 2.5 TT,
SDRAM fHERIZHEVY, SDRAM CAS (BT AT RLAR br—7) LA T —H A NEFIRT
HENTEET,

#  Row Cycle Time:

DT AT LIE. RASH T2 T 4 7R RASHT 77 4 7, 73R U A7 OHEY 7Ly
ValHERELET,

#*  Row Refresh Cycle Time:

ZOTATAE, BBV 7Ly aT7 77 47Xt RASHT 7T ¢ 7GR E 721X RASHE B U 7 L
v a R ERELE T,

# RAS# to CAS# Delay:

ZOT AT AL, A CREBICKRT 2 RASHT 7 7 1 7%t CAS"#i o E E B Z T L £,
# RAS# to RAS# Delay:

ZDTATHIE, BIpD NI DRASH TV T 4 Txt RASHT 7 7 1 7 BIEREHI 245 E L £,

#  Min. RAS# Active Time:

DT AT AL, BNDORASET 77 4 TR ZHRE L £,

#* RAS# Precharge Time:

DT AT AL, RASHT U F v — VIR ZHEELET

#  Write Recovery Time:

DT AT AE, BRICEESAATET — 25 DRAM (T & 0 ZAICEERE I THHMIE S -
MzEELET,

#  Write to Read Delay:

ZDTAT AMIIRDFEIRAH T~ ROSLH ERVICH L THREDIE~Y A F—F X hn—7F
Wi SED BN D HIE S N E R E L E T,

Z— =2 T
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# DRAM Command Rate:

2 ODA T a v 2T A~y RERIFZITa~vr ReERAT I ENTEET, T 74/ O
ENL2T 2~ FCT, ZALN (V—RAT VD) BHLETDHAEY T FLAZEET D & X,
gy ROBLIRREZ ML 3,

#  Burst Length

DDR SDRAM E ¥ 2 —/UWFINR—Z NE— FEZRHELET, N—RA bE—R&IX 4 F7201T8vs
—YarOru s T AWEE READ (SiAiA#) 721X WRITE (FHXiAHR) N—R MRICKH
LHEB TV Fy—TEr ER L £,

ZHE, N—AMREESICRETDHE, TV Fr—TTH712DIIT RUARZIRY A 7041 8
NAPMIT 7 BATHZEEERLET,

¥  Bank Interleaving:

3ODA TV a v, #EE)(Disabled) & 2 Way = 4 Way é‘fﬁiﬂh“é:&fﬁré“ia“ F 74 hD
T IX L) (Disabled) T, SDRAM ¥ = —/LREEIC L - T, “4 Way” ;&ﬁ R OMREE T’
T 2N TEET, MiETRELRINT DL, v EPa—F VAT AFR Ltjﬂﬁféé
fF&NFE A, SDRAM E ¥ 2 —/LDFEMIC OV TIE, SDRAM E ¥ o —/L ) A — 1 —IZ B4
HLEEN,

32 bit Dram Memory Hole:

CDT7T1TTFAE32Ey F DRAMAEY R—)L2Y<Ty 7TE3HELERLET, COT T T4
FEEED “Auto” FREICL TBNTL 7ZE 1,

MTRR mapping mode

CDT7 AT AIMIRR ¥ v €27 E— F&:ER L £ 9, MTRR (Memory-Type and Range Registers)
B7aty YOARVEEDT 7 AL F v v 2 fENEFHIBIL £7.

%  Advanced Chipset Features Setup Menu {250 ) ¥ 3

SSE/SSE2 Instructions:

D71 F A&, SSE/SSE2 (Streaming SIMD Extensions) &Ry E 2 AN E2ITENCTH I &
WCEET., METIBEICHEENTNET,

System BIOS Cacheable:

Disabled (/1 L72\>) 7> Enabled (Ef92) OEHOLMNIERELET, 7 7 4V MMX Enabled
T, Enabled IZETHE, L2F vy Va2 HHT 20T, A7 A BIOS OIFATHENM E
LET,

Fatallty AN8 SLI
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3-5. Integrated Peripherals

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Integrated Peripherals

» Onchip PCI Device Press Enter Item Help
» IDE/RAID Function Press Enter

USB Park Mode Disabled

USB TD Reads ISO Queue

USB Periodic Data Reads ISO Queue

USB Asyn Data Reads Non-ISO Queue

Onboard FDC Controller Enabled

Init Display First PCI Slot

Onboard IEEE1394 Controller Enabled

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

%  Onchip PCI Device:

<Enter>F—%7 Vv /95L&, $TA=a—IZAVET,
Phoenix - Award WorkstationBIOS CMOS Setup Utility
Onchip PCI Device

USB Controller V1.1+v2.0 Item Help
- USB Memory Type Shadow

- USB Keyboard Support Disable

- USB Mouse Support Disable

LAN Controller Auto

- LAN Boot ROM Disabled

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

OnChip USB:

WD 3 ODFT v a BFRETE ET: Disabled A L7V > VILI+V2.0 D VI, T 7 4V
NREL VII+V2.0 TT, ZDOT AT L% Disable (fEf L72\) IC&%ET 5 &, “USB Memory
Type” . “USB Keyboard Support” 3L T “USB Mouse Support” 7 A 7 AL Integrated
Peripherals (% 5/ #%) A =2 —CEIRTE EH A,

/N
-
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#  USB Memory Type:

CDTATAIUSBAEY X1 TE2RELET, BED “Shadow” REMN Y AT LADLEMZ
B2 25413, “Base Memory(640K)” FREZERN L TL 231,

#  USB Keyboard Support:

ZOT AT AL, DOS £ T USB ¥—AR— Faf 7 572®IZ[BIOS]%Z . OS &5 T[OS]% %
RLUET,

#  USB Mouse Support:

ZDOTATAHIZLY, DOS BBEECUSB vV AZEHT57-0D[BIOS] %, F7izik, F£721E 0OS
BREECIX[OS]|ZRIRT A LN TEET,

LAN Controller:

ZDOTATAIAYAR—RLAN 2 hr—Z 5@ TE 2 L5 LET,
# LAN Boot ROM:

ZDT AT AEA A — K LANBoot ROM i i C& 2 L HIc LT,

% IDE/RAID Function
<Enter>F—% 7V v/ 3hHE YT A=a—ITADFT,

Phoenix - Award WorkstationBIOS CMOS Setup Utility
IDE/RAID Fuction Setup

» IDE Function Setup Press Enter Item Help
» RAID Config Press Enter

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults
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% IDE Function Setup:

<Enter>F¥—%27 Vv /95L&, HTA=2—IZAVET,
Phoenix - Award WorkstationBIOS CMOS Setup Utility
IDE Fuction Setup

Onboard IDE-1 Controller Enabled Item Help
Onboard IDE-2 Controller Enabled
IDE DMA transfer access Enabled
Serial-ATA 1 Enabled
- SATA DMA transfer Enabled
Serial-ATA 2 Enabled
- SATA 2 DMA transfer Enabled
IDE Prefetch Mode Enabled

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Onboard IDE-1 Controller / Onboard IDE-2 Controller:

ZDOTAT ALY, —KRBXOKRIDE 22 bu—J O HAARE/ATREEZ DIV X 5 Z &
T&ET, BARDHNN—FKIAT7ar ba—F%BMT 521X, [Disabled] (i AR FIHE) 3%
LTL7EEN,

IDE DMA transfer access:

ZDOT AT AX, IDE F+ o F A%l L THER S NIZT 3 Ak LT, DMA £— REZER L
9,

Serial-ATA 1/Serial ATA 2:

IDOTAT NI, A F v T SATA 2> b —F OENEH 2N B2 £7,

SATA DMA transfer/SATA 2 DMA transfer:

ZDT AT AiE, SATA F > FA% 58 L THER ST T /31 A% LT DMA E— R& 3L
7,

IDE Prefetch Mode:

2ODF T a v, H(Disabled) F 721X A ZN(Enabled)Z 45 2 LN TEET, T 74 FD
SR ET ML) Disabled) T, AV AR —RNIDE RIA T A U H—T A RE, MERTIATT /&
A& 572 IDE KV 29 R—FLET, 774~V EHFEI AT KAV
IDE A 4 —T7 2 A ABLOZEOMG WY T 256 A v F—7 = A ANERY 2 HR— K
LCWR WA, 2D 7 o —)v K& #EL)Disabled) |38 E L T 7230,

4 Z— =2 T
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% RAID Config:

<Enter>F—%7 Vv /95L&, $TA=2—IZAVET,
Phoenix - Award WorkstationBIOS CMOS Setup Utility
RAID Config

- RAID Enable Enabled Item Help
- IDE Primary Master RAID Disabled
- IDE Primary Slave RAID Disabled

- IDE Secondary Master RAID Disabled
- IDE Secondary Slave RAID Disabled
SATA 1 Primary Master RAID Disabled
- SATA 1 Secondary Master RAID Disabled
- SATA 2 Primary Master RAID Disabled
- SATA 2 Secondary Master RAID Disabled

PN XM NXN
1

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

RAID Enable:

ZOT A7 413 IDE RAID BREZ AR £ 73BT LE T,

% IDE Primary/Secondary Master/Slave RAID, SATA 1/2 Primary/Secondary Master RAID:
RAID 74 A2 & LTHFA L7z T 4 A7 R L TS 72E W,

% Integrated Peripherals Setup Menu {251 D) ¥ 9

USB Park Mode:

DT AT AEIUSB/N—27F—FEHEMILET, ZOTATAIEEMBOEEICLTENT
<EEW,

USB TD Reads:

ZDOT AT AT USB TD ftAAHDE— RERINLET, ZOT7A T MIEEFEOEFIZLT
BT &N,

USB Periodic Data Reads:

ZOT AT L USB EWT —F FHRAHLDE— FERIRLET, ZOT7 A7 HIREBDE E
WL TBNTLEENY,

USB Asyn Data Reads:

ZDT AT AT USB R T — ZHSPIALDE— REFIR L ET, 207 AT LIEEEMBDO E
FIZLTBWTLZEN,

1/-—
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Onboard FDC Controller:

ZDOTATAIAVAR—KFDC a2y br—F %A TE5 L9 LET, Enabled (T 2)
F 7213 Disabled (fEf L72\) IZR%ETE EF, 7 74 /L M Enabled T97,

Init Display First:

ZDOTAT AL, VAT ANEET D EE AGP £72IEPCI A0 v b & ETUIHLT 5= 0IE
WLET,

[PCISlot]: ¥ AT AW EENITH L&, £ PCIZHWLLET,
[PCIEX]: ¥ AT AMERENTH & &, 9 PCIE 241t L £,

Onboard IEEE1394 Controller:
ZDOA T a vk, IEEE 1394 22 b — T OFRN/ES Y0 Bz £,

“I Z—P— =2 T
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3-6. Power Management Setup

Phoenix - Award WorkstationBIOS CMOS Setup Utility
Power Management Setup

ACPI Suspend Type S3 (Suspend-to-RAM Item Help
- USB Resume from S3 Enabled
Power Button Function Instant-Off
Wake-Up by PME# of PCI Enabled
Wake-Up by OnChip LAN Enabled
Wake-Up by Alarm Disabled

X - Date(of Month) Alarm 0

X - Time (hh:mm:ss) Alarm 0:0:0
Cool’n’Quiet Technology Disabled
POWER ON Function BUTTON ONLY

X - KB Power ON Password Enter

X - Hot Key Power ON Ctrl-F1l
Restore on AC Power Loss Power Off

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

ACPI Suspend Type:

IDOTAT AT, AR RE—ROF A THERIRLET,
[S1(PowerOn-Suspend)] : FEJFA > Y A NEGEZ A ATREIC L E T,
[S3(Suspend-To-RAM)] : ¥ A~ Kkt RAM #EREZ A AIREIC L £,

#  Resume by OnChip USB:

WD 2ODAT L a L NEE TE £7: Disabled (fEFH L72VY)  F721% Enabled ((EH3 %) .
57 # )V M Disabled (f&/1 L 720>) T, Enabled (fE/H73) \ZqkET 5 &, A F v 7 USB
WCHWBE 5 25T _XTOA X2 MIBENF ﬁ/bf_/XTA%ﬂ%Ut LET, ZhiZ
“ACPI AU KDH A 7 3 [S3STRICERE SN TND & EIT BETEET,

Power Button Function:

Z DT AT Lld Delay 4 Sec /> Instant-Off ICHFETE £F, 7 7 4 /v M Instant-Off TH, ¥
FOAMPMEBPICEBIRAR S L A2 AU LML HOST 5L VAT AMIY I AT (VT hT =TI
BT —F7) E—REbLVET, TNEBERY VA — =T 4 FEMOET,

WakeUp by PME# of PCI:

[Enabled] (fEFHFIHE) ICBRE L TWD L&, ET LR LAN — K72 ED A2 7R — K LAN X PCI
—REZT77®82T5E, VAT LAENOEZIHEEL 20 £9, PCL I — RO Z LR

EYVHR— NTHLERDHY F7,

Wake-Up by OnChip LAN:

[Enabled] IZRXEINTNDE, U A 7T v THEREICKIS L7 LAN 1 — RZELT, Y7 k-
F7REOPCEY T— FOLEBIELZENTEET,

Fatallty AN8 SLI z g
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Wake-Up by Alarm:

WD 2ODF T a PHEETE LT Disabled (] L72VY)  F721F Enabled ((EAT5) ,

7 7 4V N Disabled (/] L 720>) T, Enabled (f£/75) \ZRETHE. RTC (Y T4
ALT Ay IYT T =R YP AN RE— RRL VAT AENFORITH ERHERETEET,
#  Date (of Month) Alarm/ Time (hh:mm:ss) Alarm:

Aft (B) 77— W7 7 —2 (hhmmiss) 2R ETHZ ENTEET, BETHA XU B
1T R_RTC, RU—F T LTV AT AERELET,

Cool’n’Quiet Technology:
ZDOF T a ik, AMD K8 cool and quiet KEREA A ZNIC L= W LI L= LET,
¥ :SLI T— FCTEIfEL TV ARIX, ZOHEBZEMCL T EE,

Power On Function:
ZDOTATAE, VAT LOEREA AT D HEEZERLET,

[Password]: /SATU— REHEH L CU AT LAOEBREZANCLET, ZOF 7> a U ERINLT
5, <Enter>Z L TL7ZE, NAT—=REANLTLEIN, KK S5 IFETANTEE
T, EREICFC/SAT—REASN L CTHERR L2, <Enter>Z L ET,

[Hot KEY]: <F1> 5 <FI2>E TOENDPDOHREELHEHL T, AT L0OERE A I LET,
[Mouse Left]: ~TV ADERZ X TNI ) v 7 LT, VAT LAOBEREZF I LET,
[Mouse Right]: ~ TV ADERZ X TNVI Y7 LT, VAT LOER~EA N LET,
[Any KEY]: ¥—A— ROEEOF—%MHHL T, VAT 20ERE A I LET,

[BUTTON ONLY]: EFARZ > OHEMFHAL T, VAT LAOBREA I LET,

[Keyboard 98]: “Keyboard 98" A4 —R— ROERA L RN U E2FEA LT, VAT LOEFEE A
ZLET,

# KB Power On Password:

<Enter>% — %4 L HET DAV REANTHZENTEET, ANWBETTDHE, i
FEERIFELTCBIOS REA =2 — 45T L, Ay Ea— X A7 AR HEBTALERH Y 3,
0’( AL Ea—HETyy NV LT E EBRAY EHFEHL Cary Ea— 2 OERE A
WTHZ LI TEERA, AV Ea—XOEREA T HIZIE, NAT— RE AT LR
HYET,

# Hot Key Power On:

WD 15 DA T a UINFEETE E9: Crl+F1 ~ Ctrl+F12, Power (BJR) . Wake (FEOMEE Z L)
AnyKey ((LEDOF—) , T 7 4/V MI Cori+FI T, LT HAy bF—Z2RRL T, ¢
2— X OBEPREANTLHIENTEET,

Restore on AC Power Loss:
ZOTAT AIE. AC EBFICFEFENFEA LIzt D v AT DEEZ B L £,

[Power Off]: AC EIRDOIEEZRIZEFRMNEIE LT, VAT AOERIIA 72T EETY,
VAT LDOBEREA T HIIE, BRAY CEMTSLERD D £,

> i~ :
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[Power On]: AC EJROEEZRICERNEIET D &, A7 AOBPUIHBIICA 12D 3,
[Last State]: AC FEIRDOEEZICERNEET 2L, v AT MTEWFE fJ%#@“éﬁ‘ﬁ@#ﬁﬁéé:
RO ET, ACERDEENREAE LIZL IV AT ADOBENA 7 IT2> Tz b, EBIREIE
L7z Z TV AT ADERIIA 712~ £E£TT, ACERDOEENEAE L L EITVRAT
DERDA N> TV b, BIRNEIE L2 & SV AT LOERITA I £7,

Fatallty ANS SLI -
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3-7. PnP/PCI Configurations

Phoenix - Award WorkstationBIOS CMOS Setup Utility
PnP/PCI Configurations

Resources Controlled By Auto (ESCD) Item Help
x IRQ Resources Press Enter

PCI/VGA Pallete Snoop Disbaled

PIRQ 0 Use IRQ No. Auto

PIRQ 1 Use IRQ No. Auto

PIRQ 2 Use IRQ No. Auto

PIRQ 3 Use IRQ No. Auto

** PCI Express relative items **
Maximum Payload Size 4096

T ] :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

Resources Controlled By:

TOTAT AL, ETCOEBMBLIOYT T I T RF LA BT A A 2/%LET,
[Auto(ESCD)|: > AT AIEEE HEWIZHRIH L £,

[Manual]: “IRQ UV YV —RA"A=2—T, FFEDIRQ U YV —REFR L T 72 &\,

% IRQ Resources:
<Enter>¥—% 7 Vw7 §5L, W7 A=a—IC AV ET,

ZOTAT AL, FY AT KEIDRBE[PCL 734 Z] E0E [TRIFRICEE LET,
Phoenix - Award WorkstationBIOS CMOS Setup Utility
PnP/PCI Configurations

IRQ-4 assigned to PCI Device
IRQ-5 assigned to PCI Device
IRQ-7 assigned to PCI Device
IRQ-10 assigned to PCI Device
IRQ-11 assigned to PCI Device

T | :Move Enter:Select +/-/PU/PD:Value F10:Save ESC:Exit F1:General Help
F5: Previous Values F6: Fail-Safe Defaults F7: Optimized Defaults

/N
-
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%  PnP/PCI Configurations Setup Menu {250 ) ¥ 7

PCI/VGA Palette Snoop:

ZDOT AT LT MPEG ISA/VESA VGA 77— R PC/VGA CTIEEh CX 2 E 9 hERELET,
[Enabled]: MPEG ISA/VESA VGA 71— K%, PCI/VGA TEEhT& £,

[Disabled]: MPEG ISA/VESA VGA # — KX PCI/VGA TEEH L £ A,

PIROQ 0 Use IRQ No. ~ PIRQ 3 Use IRQ No.:

DT AT AT, PCl Ay MIRY T 727 34 20 IRQ HH& HEVE- X TECHRELE
T

Maximum Payload Size:

ZDT AT Ald. PCLExpress 7 /81T ADIHA TLP XA O — K41 ZEFELET,

Fatallty AN8 SLI z g
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3-8. Load Fail-Safe Defaults

ZIOFFaiIT 74 bDOBIOSEZr— R LT, bLEE LT, REDY AT L3754 —
v AERBLET,

3-9. Load Optimized Defaults

ZOFFa i, HEOFT 7 4L PO BIOS HEA T — R LT, KDY AT LNT —<
VAEFEBLLET,

3-10. Set Password

ZDOAT v a X BIOS HEREMRE LD, av Ba—F~OT 7 A%EHIRLET,

3-11. Save & Exit Setup

TOF T a ABEREZEFELTBIOS By T v F A= —52 KT LET,

3-12. Exit Without Saving

TOFFva i, BEARGFEFTICBIOS Yy T vy P A= —E2 KT LET,

4
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NVIDIA nForce Chipset FZASDA X fp—2 A-1

f1é% A. NVIDIA nForce Chipset N5 A /XA & k
—J

% : Windows A2 L—F ( VI VAT LA A h—/L L7, %7 NVIDIA nForce Chipset KZ A /3
TA VAR LTLEE,

AKHEDA A M=/ VRIEEHEEY 2 v M,
Windows XP AL —7F ( V7 L AT KIHSD
WTWET, ZOfo 0S DA A F—/LFH
LY 3 v MZOWTIE, £ 0S DA v A
7Y = DFRICHES TLTIZEN,
FIA4RNea—F7 1 VU7 4 CD % CD-ROM K
TATIHEATDHE A VA =TT TN
MAEHBIPICFETLET, BBIIZFEIT LAWY
AL ZOCDDL—hT 4 L7 NYTHEITT 7
ANEXTNI YT L, AV AR—LA=a
—IZA-TL &N,

AVA =N A= a—ITAsTb, H—Y V% .
[Drivers] # 7 (2% #h L ¥ 9, [nVidia nForce 2. [k~) #7Dy7LET.
Chipset Driver[32bit]]Z 27 V v 27 LT 7ZE0Y, e

WOBENER SNET,

The NVIDIA IDE SW dive euces the storage subsystem bollneck, enabing

eficien.

SW Diver
soluion. I you s saling NVIDIA RAID ito 3 NEW Windows Opetaing

3. k1 22097 LET,

1. [k~] 220y 27 LET, Install NVIDIA IDE SW. driver?

\ ? ) Do you want ko install the NYIDIA IDE S driver?

[ ves [ w0 |

4. [IFWV]%E27 Y v 7 LET,

fé-f/ Z—f— = T
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5 [FWEZY vy 7 LET,

7. [k~ 22V v27 LET,

NVIDIA ForceWare Network Access Manager - InstallShield Wizard

8. [kl z2VvZLEY, .

\ ? ) Do ywou want ko ackivate (On) the Firewal?

10. [TV, A9 <ara—FZHEEL
FT]2BNENDEH>BEIOLET, [T
72U I LTAVA M= ERTLET,
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B-1

f+é% B.

=T 4 F RIFA DA A b—)L

KEDOA A M—/LRIHEWEEY =2 v ML,
Windows XP A XL —F ( VU AT AT
SNTWET, FDMfD 0S DA A h—)b
FIE L EE S 5 > MZOW T, £D 0S D
FU ATV — U DIETRIZHES TLTEE W,

KA Nba—F 1 UF ¢ CD % CD-ROM
KIALTIHATDE, A1 VA —VT 1
77 APEHEICIITLET, BEICE
ITLRWGA. ZOCDDLV— T 4 L7 b
VCETT 7 ANEELTNLI ) v T L, A
VAP A= a—Z Ao TLTIEE N,

A UA NNV A =2 —|Z AT, I—
JV % [Drivers] # 7 \Z %8 L £ 3, [Realtek
Audio Driver]Z 7 V v 7 LT & W, KD
EHARRSINET,

Reallek AC'97 Audio Setup (5.03) 3

Welcome to the InstaliShield Wizard for Realtek
AC'S7 Audio

The InstallShield® \wizard wil install Relek ACS7 Audio
n your computer. To continue, click Nex!

CE] o
1L [&h~] 229 s LET,

Realtek AC'97 Audio Setup (5.03)

InstallShield Wizard Complete
Setup has fiished installng Feaek AC'S7 Audio on your
computer.

(& 3YEE. T Wari to (st my Compuler now;

€ Mo, | will restart my computer later.

Fiemave anp disks from their drives, and then click Finish to
complete setup

Finish |

2 AV SErEa—X R ERDLET
BEIRL, T2 27U v 2 LTA VA h—
NEHET LET,

uf
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USB2.0 FZA /DA fF—/ C-1

gk C. USB2.0 RTANRXDA VA ~—)L

¥E : Windows XP & 7213 Windows 2000 {235} 5 USB 2.0 KT A XD A A h—/LiX, v~( 7=
V7 MMEDOT =T A S0 HIEHTD Service Pack & ZFIH L L0,

k‘F’
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AMDG64 Processor FZ A /XDA 22X p—/b

&k D. AMDG64 Processor K7 A4 XD A A kh—)L

RIEDOA A NM—)LFIEEHEE Y 2 v ME,
Windows XP A XL —F 4 L J 3 AT MK
SNTWET, ZOfd 0S DA A h—)b
FIEE M =2 v MZOW T, £D 0S D
F AT Y= DRRRICHES T IZE N,

KA NEa2—7F 4 VUF 1+ CD % CD-ROM
KA TIHHFATDHE, f VA =171
77 AN AENICETLET, BEIICE
ITLRVWEA. ZOCDDOL— T 4 L7 b
VCEIT T 7 ANEFT TN Uy L, A
VAR A= 2= A5 TLEE,

AVAR=NAZ 2= I ADTED, A=Y
JV % [Drivers] # 7 \ZB & L £ 9, [AMD64
Processor Driver]Z 7 U v 7 LTL 7230,
WOBHRERSNET,

7 : Windows 2000 ZRL—F4Y - IAT LD

55 .0 [AMD Athlon 64 Processor Driver]
RAVIE [AMD Cool'n'Quiet Software] &3
F7,

Update Recommende d

i e you
Foundinth Know Lkatans sechon o the ‘Read e

1. [OK] 22V w7 LET,

8 AMD Athlon 64 Processor, Driver Setup (M=)

Welcome to the AMD Athlon 64
Processor Driver Installation
Wizard

It strangly reeommended that you exit al Windaws programs
before running this sstup progiam

Click Cancel to quit the satup progran, then closs any progiams
youhave nunning. Cick Next o continue the installtion.

WARNING: This pragram is protected by copyright law and
intermational treaties.

Unautherized reproduction or distibution of this program, or any
partion of &, may esult in severe civi and eriminal penalies, and
will be prosecuted to the masinum extent possibie unde lav.

7 [ cancel

2. [k~] #27 Vv 7 LET,

i& AMD Athlon 64 Processor Driver Setup

License Agreement 6
You must agree with the license agreement below lo proceed -

Advanced Micro Devices, Inc. L)
Software License Agreement E

IMPORTANT .. READ CAREFULLY: Do not load this Software until you
have carefully read and agreed to the following terms and conditions.

This is a legal agreement (“Agreement”) between you (either an

individual or an entity) ("Licensee") and Advanced Micro Devices, Inc.
(“AMD"). If Licensee does not agree to the terms of this Agreement, do

not install or use this Software or any portion thereof. By loading or

using this software that may include associated media, printed Software,
and online or electronic documentation or any pertion thereof that is

made available to download from this server or CD-ROM (*Sofiware”), ¥

@ acoept the loenss sqeement
Ol do net aceept the license agiesment

Cm ) (o)

3. “I accept the license agreement” (122
BUICRETS) EFIYIL TS, [Next] &
DUYILTRDATYINER TS,

1@ AMD Athlon 64 Processor Driver, Setup.

Readme Information

The following information describes this installation.

README RTF file for AMD Athlon(tm) 64 Processor Driver ~
(C) Copyright 2002-2004 Advanced Micra Devices, Inc. Al rights reserved

REQUIREMENTS
[AMD Athlon(im) 64 systems with ACPI 2.0 performance contral objects (_PCT)
on Windows XP

DESCRIPTION
[This driver supports processer perfarmance control wa the processar obiects
defined in the ACP| 2.0 specifcation

KNOWN LIMITATIONS:
The processor performance state may not be restored to the maximum state if

4. R~ &2V v 7 LET,

Cancel

Z— =2 T
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i& AMD Athlon 64 Processor Driver Setup

i Installer Information

Destination Folder

Select a folder where the application will be instalied.

The Wise Installation wizard willinstal the files for AMD Athlon 64 Processar Driver in
the following folder.

Toinstallinto a differsnt folder. click the Browse button, and select another folder
“You can choose not to install A0 Athlon 84 Processor Diiver by clicking Cancel to esit
the Ww/ise Installation wizard,

Destination Folder

C:\Program Fles\AMD \Processor Diivers

5. [k~] 22U vs LET,

= AMD Athlon 64 Processor Dri
Ready to Install the Application a
Click Next to begin installation 5 d

Click the Back button to reenter the installation information or click Cancel to exit
the wizard.

6. [k~] &2V vs LET,

i& AMD Athlon 64 Processor Driver, Setup

AMD Athlon 64 Processor Driver
has been successfully installed.

LClick the Finish button to exit this installation.

7. [RT] &2V v LET,

to AMD Athlon B4 Processor Diiver to take sffect. Click Yes to

% You must restart your system far the configuration changes mads
=" restart now of No if you plan to restart manually later.

8. [lIW&E2YvyZLET,

Power Options Properties

Pawer Schemes | Advanced | Hibemate | UPS

. Selact the powsr scheme with the most appropriate settings for
! this computer. Note that changing the settings below il modiy
the sslected scheme.

Pawer schemes

Home/Office Desk w

Home/Office Desk
Portable/Laptop

Fresentation

Ehways 0

i

Ma: Bollery

Tum off manar ECE LS v
Tumoff hard disks: | Never v
System standby: ‘ Never v ‘

9. VAT AHEENE 3> bu— R
o [BIFEA 7> 3 >] (Power Options) %
EIRL. [BR/NOEJFEHE] (Minimal Power
Management) D & E & #ER L T Cool
‘n’ Quiet ZEIM L TL I2E W,

¥ : X E:Windows 2000 £721& ME ¥ X T A
IZDW Tl Windows 2000 3 & ' ME FHD
Cool ’n’ QuietY 7 b7 = 71 > Ak —)b
SN TWVBE. ADM Cool *n’ Quiet X 7 7%
[EIHA 7Y 3 >] (Power Options) D NIZFHE
RENFEFT, T T, Cool ‘n’ Quiet #H
BCd BI2HIC [HEIE— F] (Automatic
Mode)lICFRET DMENDH D £,
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ABIT uGuru 2 —7 o J 7 o4 DA X p—/b

E-1

18 E. ABIT pGuru =—7 4 U7 4 DA A h—)L

RIEDOA A NM—)LFIEEHEE Y 2 v ME,
Windows XP A XL —F 4 L J 3 AT MK
SNTWET, ZOfd 0S DA A h—)b
FIEE M =2 v MZOW T, £D 0S D
F AT Y= DRRRICHES T IZE N,

KA NEa2—7F 4 VUF 1+ CD % CD-ROM
KA TIHHFATDHE, f VA =171
77 AN AENICETLET, BEIICE
ITLRVWEA. ZOCDDOL—FF 4 L7k
VCEIT T 7 ANEFT TN Uy L, A
VAR A= 2= A5 TLEE,

A UVA RN A=Za—IZA2T2b, h—Y
Jv % [ABIT Utility] # 7iCBEh L £,
[ABIT pGuru]# 7 U » 7 LTL £ &0, (RO
EHAERINET,

InstallShield Wizard E

Welcome to the InstallShield Wizard for ABIT
uGuru ¥2.1.0.6

The InstallS hield® Wizard will install ABIT uGuru ¥2.1.0.6
o your computer. To continue. click et

L [k~ 22V 97 LET,

InstaliShield Wizard

Choose Destination Location

Select folder where Setup wil install fles.
Setup will install ABIT UG V2.1.0.6 in the following folder,

Tainstall to this folder, click Next. To install to 2 different folder, ciick Browse and select
another folder,

Destination Folder

C:\Program Files\ABITAABIT uGuru Browse...

< Back

Cancel |

2. [k~ %227V 7LET,

InstaliShield Wizand

Reboot

The InstalS hield Wizard has successfully installed ABIT uGuru
Y21.06 Before you can use the program. you must restart
your computer.

& s, T Want o restart my computer nows
€ No, | vl restart my compuer laer.

FReboot

Finish |

3. [EV, ALt a— 2 EESLET
ERRL, (T2 V7 LTA VA R—
/V%f\:TbiTc

Z— =2 T
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AN8 NVRaid 7 & v E'—>F ¢ X2 F-1

46 F. ANSNVRaid 7y ¥'—F + X7

Ny r —=IfED SATA F 71 NT + A7 By R EI23HEE UizE ANSNVRaid 70 v € —
T4 A =H>THLWEDRLERL TSN,

AREDA A N—/VFRIRLEE Y 3 v MX,
Windows XP AR L —F 4 7V AT ATH
SNTWVWET, TOMD 0S DA A h—)b
FIE L BWE S 3 v MMTOWTIE, D 0S D
F AT Y= DRERICHE S T IEE N,

K4 =a—F ¢ VT ¢ CD % CD-ROM
KoL TIHATDE, f A =T
77 APEHBRNCIITLET, BEIMICE
TLRWGEA. ZOCDOLV—FF 4 L7 b
VCEIT T 7 ANEL TN ) w7 L, A
VAR A= a— T Ao TLEE,

AU A=A =ma—ICAoTah, =Y
V% [ABIT Utility] # 7B 8 L 7,
[AN8 NVRaid Floppy Disk]% 27 U v 7 LT<
SV, WOBEHARRIIET,

Raid Floppy Disk Generator,

Raid Type nfidia R aid Floppy Disk

Source CheckSum: 045245 Build

Fleaze select one floppy and insert a blank

floppy disk. About
[ ~|

1. EOo7ay¥—F ¢ A7 2RI Nz
70y E—FF1 7ICHHAL. [Build] &7
Vo7 LET,

Message

.
\{) Build Completely, and Destination checksum: 0x5245

2. [OK] 22V v 2 $5E SATA Ko 1
NF ¢ 20 DIFEHET LES .

4= Z—tf—r=a T
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POST =2 — FiE#H# G-1

£14% G. POST =2— FiEZH

AWARD POST =1 — RiEE:

POST .
(16 ) ks
CF CMOS R/W BRED T A |
F v 7ty FOBRHOEE
co -v¥% KU RAM %023 5,
L2 ¥y a BT S (Y MTEE)
R I DF Ty NLTREET T T A,
AE U O
c1 -DRAM O 4 X fEH, ECC O H @i i,
L2 ¥ ¥ v vaOHBMRE (VY NTUTF)
c3 JEA#E & 3u7- BIOS = — K% DRAM IZHETE,
cs av’“‘y7°’z~y F7 w7 %&a—1 LT, BIOS % E000 35X O FOOO 3+ K7 RAM
Zar—,
01 WELT KL 2 1000:0 (ZFfE STV 5 Xgroup 22— K& JEIE,
03 #1344 Superio_Early Init 2 A v 5,
05 1. i 249
2.CMOS DT —7 7 v 7 &HE,
07 1.8042 4 ¥ 7 = — A& %,
2. 8042 H CiR# & FIHHE,
1. Winbond 977 ' U — X ® Super /O F v FZkt L TR/ —AR—Far br
08 —Z %7 A b,
2. ¥ —AR— A BT =—AEHIT 5,
LPSR VAL X T 2 —AEWHITH (FTay) ,
oA 2. A= FBLPAS VH T 2—ARAT v T D®KIZ DFH—FR— R~ AHKR—
rOBHBRH (K7 a )
3. Winbond 977 ~ U — X ® Super /O F > STk L THF—A— K& Vv I,
OE FOOOhEZ Av hix RU%ETANLT, N0 RW RIETH D070 0%
RAE TFANBRERKLED, AC—INRE—TFE2RLET S,
10 7Ty vaOfEE BEMR LT, M@k Ty a RIW 22— K% F000 N
T A A AERICE— R L7225, ESCD BLUDMI 2% 7HR— h,
T —F 1 OTNTY XLEHEH LT CMOS [EEENOA 7 7 2 — A%k
12 &, Fio, VTNAEA LD ay ZERIREZZRE LT, KIZAH—R"—F 4 K
T,
14 Fo Ty NOTF 74N MEEF v T2y NIl T A, FuT 2y bO
77 4 /v MiEIX OEM % (Z X Y MODBINable,
16 Early_Init Onboard_Generator 23 E# SN TWAHEOPMA R —Krm v s
Pxxlb—#, POST26 H L2 &W,
y S—

y f—

Z—P— =2 T



G-2 1187 G
18 7'Z K, SMI OFFSE (Cyrix 7213 Intel) 35 LN CPU L~L (586 & 721 686)
% & CPU THFH O,
WIHAEN Y IAZART B VR, FRIRE SN TR WEE, 3To H/W E1V A4
1B I% SPURIOUS_INT_HDLR & S/W %11 3AZ %> & SPURIOUS_soft HDLR (23 51
EX
1D W14 EARLY PM_INIT A A > F.
1F F—R— Rz —F (/= T v 7DFTTy bTH—20) ,
21 HPM O#HE (/= T v o7 DT7 Ty v T x—24)
1. RTCEDZ Y4 MEZF = v 7 il : 5Ah OfEIL RTC 7y DB MR/l & 720 £
ED
23 2. CMOS #%7E% BIOS A ¥ v 7 Zr— K, CMOS F = v 7 AR KM L71=54 .
ZORDOVIZT 740 MEZERA L TLIZEN,
24 PCI & PnP % f# 4 234 BIOS U VY — R % #&fiii, ESCD 2 A %) Tdh i, ESCD
DUA—IEREEBICAN T I,
7 — U —PCI #1H1k:
25 -PCI N RAFE 5w FIZE,
AFV&IO VY —AZE D YT
-F 272 VGA device & VGA BIOS ZIR%& L, 1% C000:0 [IZ ANVET,
1. Early_Init Onboard_Generator 234> R — K7 1 v 7 ¥ =3 L—Z YL & E
HINTWRWEAR, ThEhorsry 7 ) Y —R 8T 5bE&, PCI&
26 DIMM A" v MIZEIZRY £,
2. Init > R — K PWM
3. Init 4> R — K H/W &= Z L&
27 INT 09 /N> 7 7 & ¥IHHE,
1. 0-640K AE U 7 KL A% LT CPU &S MTRR (P6 & PI) & 7' 12 7' T A,
2. Pentium 7 7 A CPU |Z%} LT APIC % ¥k,
29 3.CMOS &ty N7 v FICXk»CT—U—F w7y haTrar I, Bl £
—RIDE 2> br—3,
4. CPU % JIE,
2B v 4 BIOS % FFOVH L
L2234 bEE7 x> b (7 a )
2D 2. Award % A b/, CPU OFfi¥H, CPUME, Z/LVEa A2 8D, A A7 Y
— VT 4 AT VATERE TR,
33 Early_Reset KB 2NN/ > TV DA, ¥—A— K& V&> b, fil: Winbond
977 > U — X Super /O &~ 7, POST 63 1 ZHE 7280,
35 DMA F % XL 0% T A b,
37 DMA % 3V 1 %7 A |k,
39 DMA X—J LA X %ET A B,
3c 8254 %7 A b,
3E F XV TIZH LT 8259 ENVIABL~Y AT E Yy hET A B,
40 F ¥ RV 2WHK LT 859 ENNIAAR~T AT By T A B,
43 8259 HEEZ T A K,
47 EISA 21 v hZ#IHi1L,

Fatallty AN8 SLI
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1. % 64K X—Y OFEDZ TN T — RET AT HZEIE- TR ATV &
49 FH5,
2. AMD K5 CPU |Z%f L CEZALFI VY CTETa T L,
1.M1 CPU ® MTRR % 7' 11 7' L,
2.P6 7 TAIZRI LT L2 ¥ v v ooz L, #72% v v 2 R/
4E RO CPU R T /T A
3.P6 7 T A® CPU IZ%f L C APIC ZHIHL,
4 MP 7T v N7 4 —A5 LT, & CPUIKDOF ¥ v ¥ = AIREARFFAN —F L2\
W, ¥ v o ARERHEIPH A X0 /N S e diBHIC R,
50 USB % #)#i1k,
52 FTRTOAEYET AL (TRTOIEEEINTZAEVEZ0IZZIT)
53 HW ¥y R/ TRAT—=RE 7 YT (T a )
55 TatyoREER (ZETaEy YOS Ty T H—4)
PnP & I %3,
57 W13 ISA PnP % )1k,
-CSN %4~ T ISA PnP & |2E| 0 24T,
59 FEG &7z Trend 7 4 Vv AP 1E o — R 2 #1H(k,
5B (A7 a HRE
FDD 75 AWDFLASH.EXE # AJJ 95720 D A v —Vh2FR (AT a V),
o 1. Init. Onboard_Super 10 % #JH#i{t.
2. Init Onbaord AUDIO % #Jii{t:
60 Setup = —7 4 U7 4 DATIBATRE;DFE VW, 2D POST A7 — %5 CMOS Ok
v T v T a—F 4 VT 4 & AT D FE TIEATIRAHE,
63 Early Reset KB 3EFRK SN TWRNGE, F—FR— K& Ut b,
65 PS/2 = 7 R &1L,
67 BgBE 1 — L ¢ INT 15h ax=E820h (Z%f LT A€ U %A XDOIEH % Ul
69 LXyviartd it b,
B Setup B L HEMERBENICFUIR SNHEBICE-CF v Ty NLUA X &
Tary g A,
1. VY —RZA%9~To ISA PnP #2510 4T,
6D 2. Setup NOXHET BHE BAUTO”IZERE SN TV A A, A— K Ed CcOM
A— MZHAR— h&EEID KT,
F 1. 7uyv—ar hue—7zg#1,
2.400— Ry =7 TC7uy b —llETL7 s — L Kby b T v 7,
75 4 _TCo IDE ¥#& (HDD, LS120, ZIP, CDROM 72 &) ZHHL., £ A h—
b
(A7 a H4EE)
76 AWDFLASH.EXE % A JJ:
-AWDFLASH 37 8 v E'— KT A ZIZA 20> 254,
SALTHR2 8 L TV A A
77 YT NR—NERT LIVR— N &K,
7A avatyYERHELL A R—1,
7C Init HDD # & iA 774
> i~

Z—P— =2 T



G-4 18 G
EEE R AN R—FENTHWEHAE, TFA FE— RV EZ,
7F ST —BRETIEE, =T —FHRE LI AT EFFO,
ST T —NEAELZWEA. FIEFI =B IN TV DA T,
¢EPA 723 WA S v A X ETzndx= T VT,
ESPOST.ASM D & & — h
1.7y 7y NEREEY v 7 23—,
82 2.EPAu:“4:;oT1ﬁ)ﬂéﬂTb\ TXARNT Y MNeEHE (E@E e TR
LIRS R—1) |
3. XA — RBRRESNTNDEH, SAT— RO AN ZRD D,
83 AB DT XTOT —HF % CMOS ([ZIRF LIET
84 ISA PnP 7' — k35 2 W)L,
85 1. USB HcA&#31L
2. B Z T ¥ A NE— RIZU Y EZ
87 NET PC: SYSID ##§1& DS
89 1. IRQ % PCI 7 /34 R IZHI Y KT
2. AFVDO LM TACPIEER Y T v,
8B 1. T_RTCTOISA 7 X 7% ROM IO L
2. 9_TCT® PCIROM % MO L(VGA % FR<)
I.CMOS v N7 v W~ TRY T 4 F = v 7 O/ 200z
8D
2. APM #1#i1k
8F IRQ ® J A X% {2
93 Trend 7 4 VARG IE 22— RiZxt L CHDD 7 — h &7 X IFHROFEAIA I,
LL2Fxy v =a%2H%
2. BHEIFRE A T 0 7T A
3. @l E e ST A
94 4. F v 7y b OEKIIEIL,
5. EIEAE B OO B AL
6. Wiffi & 7 1 AT LA OEHREHEE
7.K6 EZXALEI VY TET BT T A
8.P6 7 7 ADEXIALLGRET 0T T A
95 Update & —74~— K LED & typematic rate (5 —@D 74— h VU &— F#HEE)
1. MP % & %48,
2. ESCD ##A#4E L 50T,
96 3.CMOS &> F = U —% 20h £721% 19h ITFEE,
4. CMOS Hffl % DOS DX A ~F v 7iZr— K,
5. MSIRQ D% FE 8 &3 & WG4,
FF A% 7 — H(INT 19h),
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G-5

AC2003 POST =— REH :

POST
(16 #EE)

#

BEA L~ R

EIRA L L — o ZADBA

ATX EIEEOAR)

ATX FEJEEE OWERET

DDR EJED¥EE T

CPU =— REEIZKH L TPWM Aty F 7 v

CPU = — NEEICK L TPWM 27 9 — |

CPUET—FEELF =v 7

CPU = 7 BIEDHEFE T

M ay 7L —%IC

) —=AT7 ) yVF v Ty NEEOUERET

AGP EEOHEfFTE T

3VDUAL EED HEff5E T

VDDA 2.5V FEBJEDOHEFE T

GMCHVTT & DO e 5 T

CPU 7 7 VHEDTF = v 7

T~ ol L% 7 ) —

© [oo|oo||o||o|o|m|m|m|m|m|w|w|w|wn
mEOoQE|P v o dolvula|lw| N|R

o

uGuru I 7 m v A 25T
AWARD BIOS L&) ¥ o 7 & {7k

EBRA7—Fr v R

ERA 7 > —4 v A & Bk

FTRTOBEROT Y — Mk

BERA L OTH— R

LDT NAERB T — MEIE

CPU 2 7 HBEICKT 5 PWM O 7 H— Mk

CPU 2 7HEEDT ¥ — ML

CPU 27 EEDTF = v 7

ATX BIEEO T % — MEIE

vV vivlvw|lv|v|lv
Wo|d|n(U|d|W|IN|F

WA 7 — AT

Z DA

AE Uty b

V7 =7 YEy b

EBIRA L L — L ADIA LT U b

LRGN RG]
WwW(N| |

BIRA 7=V ADZA 2A T

EE: T O/ I, AC2003POST 77 ¥ a v &#FATLTVD L X ITHEITLET,

Z—f— = T
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PEZTN 2 —F g H-1

H8H. FNSTNYa—F 45

Q&A:

Q:
A:

FLWPC VAT LEMBILTSH EXITCMOS 227 VT TEHERDHY E35?

TV, L P —R— RE2EETHERIC, CMOS 227 V7352 L2 BED LET,
CMOS V¥ v REFT T/ D 12 DRI a winb 23 DRIy a B L, 23 %L,
ZLTRIELTLES N, YATLAZFLOTRETILEE, 2P —X~v=aTVEDS
R L. Load Optimized Default % FFONAA CTL 72 &1,

BIOS BEHHIINV T v LT LES7Y HiEo72 CPUNRTFA—FERELTLE ST
BARIZIEI LEEb X WTL X 9 H?

BIOS B DLIL.CPU /N T A —ZBREME VN LDV AT LD T T v 5 L&,
HIZCMOS 7 U 7 &{THo CTH A REBSETHTIEEN,

BIOS Wi CA—N—2 0y 7 E1-I3EEREOREERAS D &, VAT LEEETEXF, H
EILAHRRENETA, A VR — FRBEELIZOTTN? AL R — FERREICRA
TAHOLERS D T, XX RMA 2R %2TH RETTHN?

—HBD BIOS i E&ET 7 4V hinbA— =7 v v 7 £I3IFEEOREICEF L TH,
— R =T EFAA AR — RPKARICHEET HRK & 13720 /A, BTl KD 3
DD T TNy a—T 4 7ICE->T CMOS T—F 2B L, "— KU =T DF 7 4/ b
OWREIZFETE L ICBEO LEST, 2k, A R—FRFOHEEL, 22— —
DEWOEDOEIAAL VAR—=REBEWETFRHEOFREICRELZY . RMA 7t A% FETT
LT e 9,

1. BIFEEOERZAZIZL, 1 HBICHRAS AT LET, BENF AR D RVEA.
FER T — FE2RONT I HBIZELIAALTIIEE WD, F—R— FO<Insert>F — & L 7= F
T, BRACAREZ U EMLTCUAT AEREILET, EFITEBILES, <nsert>F—%
BEL . <Delete>F—% L TBIOS Y b7 v 7= A TELWEEZITWET,
INTHRENRIE LRWES, AT v 71 23 ERV RSN, 2T v 722 ATL
7ZEW,

2. BIEEOBFREZA7ICTH50BRa— FE2HKWT, Yy —Y &£, BlhofEc
CCMOS Vv Y 3B H D ET, Py L/ LEET 7 40 b D 1205 23121 AT L
TCMOS F—Z % MBE L., BOT 74NV MDD 12ICRLET, vy —I 20, Bk
BEOEREANCT 20, BRa—F2ELIALET, BFAVARZ 2L T, VA
FAEEHLET, EFICREILZS, <Delete>F—%#L T BIOS v b7 v 72—
VICAST, ELWEEEZITVWET, ZATHLRENEEL2WEA, 2T v 73 2R
FHTLTEEN,

3. AT v 72 LREILFET, A—rBR—Frb ATX B %7 # 2k E . CMOS 25 iE
LTCWDHRINZAAL v AR— FOEMERD AL ET,
TI = ANFR— P LOREREEE ZDITITED Lib XWTTH?

DX =aTIVOEIHD, T 7 =AY R— 73— OB EIHE-> TR L TL
X,

L/TE/

A=

Z—P— =2 T



H-2 118 H

IEICRIBED & 256, DT 7 =Y R— FF— A0 REEZ TP < FFE L CHitl 2
T RARALZANTED LD 77 =¥ R— FIRICIE, MEICBERO RV EDERSRZ A
WP, BEREDEIROLEZFTLA LT EI VN, RRARIE, 77 = R— s bEE
ERonsd &5, WREWMALLZT 4 —7 —EIFMGEEIC Fax LTLZE W (Toflas
LTS |

#l1: ~¥P—mr_R—F (CPU, DRAM, COAST 72 &% &%) . HDD, CD-ROM, FDD, VGA
CARD, VGA #— F, MPEG #— R, SCSI #— R, ¥+ 7> R — KR EEEIeT AT LN
HETEX2WGA, LTFOFIBEIES TV AT ADFER AV R—FR 2 b aeTF v 7 LTLTE
EV, RUINT, VGA I — RUSNDTRTDA L F T 2—Ah— FERY 4L CHEES LT
<TEEW,

ZFhTHLREE LARWVWES

o777y REZIFET VDO VGA H— RK&EA VA =L LT, VAT LABNEHTINE D
PRLTHATL S, TRTHEREI LARAWESIX, 77 =003 FR— N (EhEEF
EBMR) IZVGA H— ROEFNL, = F—R— ROEF /L4, BIOS ® ID FE. CPU OfE
HATAL, “REOSBMICBIC O W TORE LW ZTEA L TL 7F &,

HET 554

BYBRWZA VH T 2= AN —FRE 1 D1 DTICRLEN S, VAT LANES L b %
TUATLADE#ZF =7 LTLIEEY, VGA I — RERBEDRER otz v X T =
— AN —REERLT, TOMOH— FE I OEDEMRERY AL T, AT A2 FHOEH) L
TLEE, ZRTHERE) LA2WEA, "2OMO T — R"OMIZ 2 #o — RIZBET 2
FRRALTLLEEN, B, v~ —FKR—RFKOET L4, /S—Y 3, BIOS®ID %%, CPU
O (EREEFHEEBR) | BLOEZMEICOWTOHE LW ZILAT D EZENLL N
TLEEW,

fl2: ~H¥—AR—F (CPU, DRAM, COAST 72 ¥ % &%) . HDD, CD-ROM, FDD, VGA
H— R, LAN #— F, MPEG #— K, SCSI 1 — K, ¥+ R — R EE2EH Y AT AT,
YU RI—RDRTANDA A=)V, VAT LEHEBLZY, YU FI— KD
RIANEFATLEDTHEHBNC) Yy FLTLESHA, MEITY Y RA—FD K
FANRNZH LN LIvER A, DOS OfESEIO®R T ¢, SHIFT F— % L C CONFIG.SYS &
AUTOEXECBAT #4M L CL 728, £72, 7F A =7 1 ¥ T CONFIG.SYS Zf&1E LT
<IEEW, ¥y RI—RFRDRIFIA N Ea— RT5{7ICY~—2 REM 2875 &, v
VRA—=FRKDORIAN%OFFIZT& T, TORlZITEIZEW,

CONFIG.SYS:

DEVICE=C:¥DOS¥HIMEM.SYS
DEVICE=C:¥DOS¥EMM386.EXE HIGHSCAN
DOS=HIGH, UMB

FILES=40

BUFFERS=36

REM DEVICEHIGH=C:¥*PLUGPLAY¥DWCFGMG.SYS
LASTDRIVE=Z

VAT AEFHEB L TAHATLESN, YATFAREEHLTY Yy b LARWES, METY Y
VRA—=FRDORIANZHDLZ NNV ET, 77 =NV R— AR (EREEFES
B) 1Yoy Fhh—FROETF LAY, P —R—FKDET /L4, BIOSDID HF =&AL, "
RIBEOFHTICEE LW ZFEA L T Z &0,

T =ANYR— b T = AOFLBOATT IO THI L E T,

/.
A
y f—
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EREEER..
[7 7 =1 R— MIK] OB EFREEZTLAT IHE, ROEFHET > T TZEN,

*

1.

10.

.08/ TV r—varv FEHLTWY

TN 22—~ o2 TR ENTWEET AL ZRALET,
% : Fatallty AN8 SLI

. PP—R—FKDEFNVEFE (REV) : vV —R—RK|Z [REV:*** ] L& TWDH <P —

= ROEFAFEZETAL TS,
% : REV: 1.00

3. BIOSID BEIHAEE : AL A7 V=0 DA =V TELES D,

CD-Title Rev. No.

RIARNR=D gy : FTRALART

ANRNDT 4 27 (b LbiL) I
[Release *.**7] 72 L LFIN TV D

N—=T g U FESEFTLALET,

LT ], I Device Drives
i

Drivers Diskette Brlease 1G04
K

Floppy Disk Driver Rev.No.

508 BLOV AT ATRE LTV
AT FVr—a B ALET,
i : MS-DOS® 6.22, Windows® 95, Windows"™ NT....

. CPU: CPU DA —N—ZBIOEE (MHz) 2FALET,

Bl (A [A—H—4] OMIZIE [Intel] . [{EBE] OMIZIEL [Pentium® 4 1.9GHZ] & 52
ALFET,

HDD : HDD ® A —7—4%, fL£k, OIDEI 53X OOIDE2 D EH 5 THEH L TV A0 ETEA
LET, T4 AVRERDPDIGHEIIAFREZTRAL, [O] 2F=zv s (vv7) LTLE
SV, Fxy 7 BRWEEIE. [MIDEl] ~AZ—LBRLET,

B [HDD] DB DR v 7 A% F = v 7 L, A —HI—4 2% [Seagate] TAERDOMIZIZ[ST31621A
(1.6GB) ] LRALZET,

CD-ROM KA 7 :CD-ROM KT A 7D A—H—4, {4k, OIDEl B X VOIDE2 D X5 5
THEALTCWDINETRALET, £/, 0" 2F v 7 (V) LTLKEZY, Fzv IR
RVEAIL, “MIDE2"~ A X — & Zip LET,

#] : “CD-ROM K7 A 7"ORDOR v 7 Z%eF v 7 L, A—F—2IZiF “Mitsumi”, {LEED
MIZIE “FX-400D” LA L E9,

Y ZAF N AEY (DDRSDRAM): AT AAFY DT T Fe| HBE HH, £YVa—La
VAR—R Y b, BV 2 AERE R, CAS LA T Uy, HE (MH2)? XL H 72, fEE% (DDR
DIMM) %k LET, 72& 2. 75 FAR—2{Z, [Micron) &L, HEERAR—2
LT X D ICiEil LET,

HEJE: 128MB, #HA: SS 16 Megx72 2.5V ECC I—/L K, EYV a—/ba R R—F% 2 :(9) 16
Megx 8, & ¥ 2 — Lilh & 5 MTOVDDT1672AG, CAS LA 7 > 3: 2 @ (MHz): 200 MHz.
BV DDR SDRAM DRl E#R A2 BMOLEL ZE W, BELEZMEEZ Y I 2 L— T
5 ETRNMZEIZIHET,

ZOMDOA— 8 BREICBER L TS0 “HdiETHD” h— REFLALET,

M DIRKRPFFE TE WG AL, VAT AHEH L T AT RTOI— RERAL T K
S0y,

R[] oHEERERSLTRALTIES VY,

Z— =2 T



H-4 116 H
T 7 =Y R— b K

e =4 B EiHE5

& HESE Q@ T I AK

@0 E-mail :

ET L4 * BIOS ID # *

VPR — RO RIANRNR=T g

ETNE S i -

OS/ 77V r—vayv

N— R T4 A= —24 kg
CPU *
JIDE1
HDD CiDE2
CD-ROM [JIDE!L
N2 [JIDE2
VAT AAEY
(DRAM)
oMo — R
RIEDFHT
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FI =Y — DRI HIZ00 T I-1

ML T =AY E— FDOZITFITONT

(FR—2~—) http://www.abit.com.tw

(CKIE) http://www.abit-usa.com
(2—nu v X)) http://www.abit.nl

ABIT #£® ABIT Fatallty i 2 BE W EIF W& H O R EH TZ0ET, ABITIET 4 A R
ta—% VEI7— VATAL T 7L —F 2@ L TRHEZRFEIE TN TEY £972
W, T Ra—PFOERRICEHERR ZIRTET 5 2 LidH 0 /A, BT 7 =R — M~
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